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PART – I  
COMPUTER SCIENCE 

 

1. Which of the following is not used as secondary storage ? 
 (a) Semiconductor memory (b) Magnetic disk 
 (c) Magnetic drum (d) Magnetic tape 
 

2. MICR system is used in which of the following field ? 
 (a) Bank (b) Hotel (c) Hospital (d) House 
 

3. The disadvantage of dynamic RAM over static RAM is 
 (a) Higher power consumption 
 (b) Variable speed 
 (c) Need to refresh the capacitor charge every once in two milliseconds 
 (d) Higher bit density 
 

4. Which of the following codes needs 7 bits to represent a character ? 
 (a) ASCII (b) BCD (c) EBCDIC (d) Gray 
 

5. Which one of the following is not a client-server application ? 
 (a) Internet chat (b) Web browsing (c) E-mail (d) Ping 
 

6. The hexadecimal number A23F is represented in binary by 
 (a) 1010 0010 0011 1110 (b) 1010 0100 0011 1111 
 (c) 1010 0010 0011 1111 (d) 1111 0011 0010 1010 
 

7. Error detection at the data link level is achieved by 
 (a) Bit Stuffing (b) Hamming Codes 
 (c) Cyclic Redundancy Codes (d) Equalization 
 

8. Which of the following is single user operating system ? 
 (a) MS-DOS (b) Unix (c) OS/2 (d) None 
 

9. Plasma Panel is 
 (a) Input Device (b) Output Device 
 (c) Memory Device (d) Communication Device 
 

10. Baud means 
 (a) The number of bits transmitted per unit time. 
 (b) The number of bytes transmitted per unit time. 
 (c) The rate at which the signal changes. 
 (d) None of the above 
 

11. www uses protocol 
 (a) FTP (b) HTTP (c) WBC (d) MTP 
 

12. Which of the following is an example of an optical disk ? 
 (a) Digital Versatile Disk (b) Magnetic Disk 
 (c) Memory Disk (d) Databus Disk 
 

13. To access a mainframe or super computer, users often use 
 (a) Terminal (b) Node (c) Desktop (d) Hand held 
 

14. Which is the fastest memory ? 
 (a) CD-ROM (b) RAM (c) Registers (d) Cache 
 

15. A name or number used to identify a storage location is called  
 (a) Byte (b) Carry bit (c) Record (d) Address 
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³ÖÖÝÖ ³ÖÖÝÖ ³ÖÖÝÖ ³ÖÖÝÖ ----    IIII 
Ûú´¯µÖæ™ü¸ü ÃÖÖ‡ÓÃÖÛú´¯µÖæ™ü¸ü ÃÖÖ‡ÓÃÖÛú´¯µÖæ™ü¸ü ÃÖÖ‡ÓÃÖÛú´¯µÖæ™ü¸ü ÃÖÖ‡ÓÃÖ    

1. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ×«üŸÖßµÖÛú ÃÖÓ“ÖµÖ Ûêú ºþ¯Ö ´Öë ¯ÖÏµÖãŒŸÖ ®ÖÆüà ÆüÖêŸÖÖ Æîü ? 
 (a) †¬ÖÔ“ÖÖ»ÖÛú ´Öê´ÖÖê¸üß  (b) “Öã´²ÖÛúßµÖ ×›üÃÛú  (c) “Öã´²ÖÛúßµÖ ›Òü´Ö  (d) “Öã´²ÖÛúßµÖ ™êü¯Ö  
 

2. ‹´Ö.†Ö‡Ô.ÃÖß.†Ö¸ü. (MICR) ¯ÖÏÞÖÖ»Öß ÛúÖ ˆ¯ÖµÖÖêÝÖ ×®Ö´®Ö×»Ö×ÜÖŸÖ ´Öë ÃÖê ×ÛúÃÖ õÖê¡Ö ´Öë ÆüÖêŸÖÖ Æîü ? 
 (a) ²ÖïÛú  (b) ÆüÖê™ü»Ö  (c) †Ã¯ÖŸÖÖ»Ö  (d) ‘Ö¸ü  
 

3. ›üÖµÖ®ÖÖ×´ÖÛú ¸îü´Ö ÛúÖ †¾ÖÝÖãÞÖ, Ã™îü×™üÛú ¸îü´Ö Ûêú ÃÖÖ¯ÖêõÖ Æîü  
 (a) ¯ÖÖ¾Ö¸ü Ûúß †×¬ÖÛú ÜÖ¯ÖŸÖ  
  (b) ¯Ö×¸ü¾ÖÙŸÖŸÖ ÝÖ×ŸÖ 
 (c) Ûîú¯Öê×ÃÖ™ü¸ü Ûêú †Ö¾Öê¿Ö ÛúÖê ¯ÖÏŸµÖêÛú ¤üÖê ×´Ö»Öß ÃÖêÛúÞ›ü ´Öë ¸üß±Ïêú¿Ö Ûú¸ü®Öê Ûúß †Ö¾Ö¿µÖÛúŸÖÖ ÆüÖêŸÖß Æîü …  
  (d) ×²Ö™ü ‘Ö®ÖŸ¾Ö †×¬ÖÛú Æîü … 
 

4. ‡®Ö´Öë ÃÖê ÛúÖî®Ö ÃÖÖ ÛúÖê›ü, ‹Ûú Ûîú¸êüŒ™ü¸ü ÛúÖê ¯ÖÏ¤üÙ¿ÖŸÖ Ûú¸ü®Öê Ûêú ×»Ö‹ ÃÖÖŸÖ ×²Ö™ËüÃÖ »ÖêŸÖÖ Æîü ? 
 (a) ‹.‹ÃÖ.ÃÖß.†Ö‡Ô.†Ö‡Ô.  (b) ²Öß.ÃÖß.›üß.  
 (c) ‡Ô.²Öß.ÃÖß.›üß.†Ö‡Ô.ÃÖß.  (d) ÝÖÏê  
 

5. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö Œ»ÖÖ‡®™ü-ÃÖ¾ÖÔ¸ü ¯ÖÏµÖÖêÝÖÖ£ÖÔ ®ÖÆüà Æîü ? 
 (a) ‡Þ™ü¸ü®Öê™ü “Öî™ü  (b) ¾Öê²Ö ²ÖÎÖˆØ•ÖÝÖ  (c) ‡Ô-´Öê»Ö  (d) Ø¯ÖÝÖ  
 

6. ÆêüŒÃÖÖ›êüÃÖß´Ö»Ö ÃÖÓÜµÖÖ A23F, ²ÖÖ‡®Ö¸üß ´Öë ¯ÖÏ¤üÙ¿ÖŸÖ ÆüÖêŸÖß Æîü  
 (a) 1010  0010  0011  1110  (b) 1010  0100  0011  1111 
 (c) 1010  0010  0011  1111  (d) 1111  0011  0010  1010  
 

7. ›üÖ™üÖ Ø»ÖÛú ÃŸÖ¸ü ¯Ö¸ü ¡Öã×™ü ÛúÖ ¯ÖŸÖÖ »ÖÝÖÖ®Öê ´Öë ¯ÖÏµÖãŒŸÖ ÆüÖêŸÖÖ Æîü  
 (a) ×²Ö™ü ³Ö¸üÖ¾Ö  (b) ÆîüØ´ÖÝÖ ÛúÖê›ËüÃÖ  
 (c) ×®Ö¸ü£ÖÔÛú ‘Ö™ü®ÖÖ “ÖÛÎú ÛúÖê›ËüÃÖ  (d) ÃÖ´ÖÖ®ÖßÛú¸üÞÖ  
 

8. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ÃÖÖ ‹Ûú»Ö ¯ÖÏµÖÖêÝÖÛúŸÖÖÔ †Öò¯Ö¸êüØ™üÝÖ ×ÃÖÃ™ü´Ö Æîü ? 
 (a) ‹´Ö.‹ÃÖ.-›üÖòÃÖ  (b) µÖæ×®ÖŒÃÖ  (c) †Öê.‹ÃÖ./2  (d) ÛúÖê‡Ô ®ÖÆüà  
 

9. ¯»ÖÖ•´ÖÖ ¯Öî®Ö»Ö Æîü  
 (a) ‡®Ö¯Öã™ü µÖÓ¡Ö  (b) †Öˆ™ü¯Öã™ü µÖÓ¡Ö  (c) ´Öê´ÖÖê¸üß µÖÓ¡Ö  (d) ÃÖÓ“ÖÖ¸ü µÖÓ¡Ö  
 

10. ²ÖÖò›ü ÛúÖ ŸÖÖŸ¯ÖµÖÔ Æîü 
 (a) ‹Ûú ×®Ö×¿“ÖŸÖ ÃÖ´ÖµÖ ´Öë Ûãú”û ÃÖÓÜµÖÖ ´Öë ×²Ö™ËüÃÖ ³Öê•Ö®ÖÖ … 
 (b) ‹Ûú ×®Ö×¿“ÖŸÖ ÃÖ´ÖµÖ ´Öë Ûãú”û ÃÖÓÜµÖÖ ´Öë ²ÖÖ‡™ËüÃÖ ³Öê•Ö®ÖÖ …   
 (c) µÖÆü ‹Ûú ¤ü¸ü Æîü ×•ÖÃÖ ¯Ö¸ü ÃÖÓÛêúŸÖ ¯Ö×¸ü¾ÖÙŸÖŸÖ ÆüÖêŸÖÖ Æîü …   
 (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà … 
 

11. ›ü²»µÖæ.›ü²»µÖæ.›ü²»µÖæ. ¯ÖÏÖê™üÖêÛúÖò»Ö ¯ÖÏµÖãŒŸÖ Ûú¸üŸÖÖ Æîü  
 (a) ‹±ú.™üß.¯Öß.  (b) ‹“Ö.™üß.™üß.¯Öß.  (c) ›ü²»µÖæ.²Öß.ÃÖß.  (d) ‹´Ö.™üß.¯Öß.  
 

12. ‡®Ö´Öë ÃÖê ÛúÖî®Ö ÃÖÖ †Öò×¯™üÛú»Ö ×›üÃÛú ÛúÖ ˆ¤üÖÆü¸üÞÖ Æîü ? 
 (a) ×›ü×•Ö™ü»Ö ¾ÖÃÖì™üÖ‡»Ö ×›üÃÛú  (b) ´ÖîÝÖ®Öê×™üÛú ×›üÃÛú  
 (c) ´Öê´ÖÖê¸üß ×›üÃÛú  (d) ›üÖ™üÖ²ÖÃÖ ×›üÃÛú  
 

13. ´Öê®Ö ±Ïêú´Ö µÖÖ ÃÖã¯Ö¸ü Ûú´¯µÖæ™ü¸ü ¯ÖÏµÖÖêÝÖ ´Öë, »ÖÖ®Öê Ûêú ×»Ö‹ µÖæ•Ö¸ü ¯ÖÏµÖãŒŸÖ Ûú¸üŸÖÖ Æîü  
 (a) ™üÙ´Ö®Ö»Ö  (b) ®ÖÖê›ü  (c) ›êüÃÛú™üÖò¯Ö  (d) ÆîüÞ›ü Æêü»›ü  
 

14. ‡®Ö´Öë ÃÖê ÛúÖî®Ö ÃÖ²ÖÃÖê ŸÖê•Ö ´Öê´ÖÖê¸üß Æîü ? 
 (a) ÃÖß.›üß.-¸üÖê´Ö  (b) ¸îü´Ö  (c) ¸ü×•ÖÃ™ü¸ü  (d) Ûîú¿Öê  
 

15. ³ÖÞ›üÖ¸üÞÖ Ã£ÖÖ®Ö ÛúÖê ×“Ö×Å®ÖŸÖ Ûú¸ü®Öê ÆêüŸÖã ¯ÖÏµÖãŒŸÖ ÆüÖê®Öê ¾ÖÖ»ÖÖ ®ÖÖ´Ö µÖÖ ÃÖÓÜµÖÖ ÛúÆü»ÖÖŸÖß Æîü  
 (a) ²ÖÖ‡™ü  (b) Ûîú¸üß ×²Ö™ü  (c) ×¸üÛúÖò›Ôü  (d) ‹›ÒêüÃÖ  
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16. A ______ acts like a translator between the device and programs that use the device. 
 (a) Interpreter (b) Device driver (c) Compiler (d) None of these 
 

17. A storage area used to store data to compensate for the difference in speed at which 
different units can handle data is  

 (a) Memory (b) Accumulator (c) Buffer (d) Address 
 

18. What is the name of the arrangements where several central processing units share one 
memory ? 

 (a) Multitasking (b) Multiprogramming 
 (c) Concurrent programming (d) Multiprocessing 
 

19. A page fault occurs 
 (a) when the page is in the memory. 
 (b) when the page is not in the memory. 
 (c) when the process enters the blocked state. 
 (d) when the process is in the ready state. 
 

20. A tree structured file directory system 
 (a) is not essential when we have millions of files. 
 (b) is a much debated unnecessary feature. 
 (c) allows easy storage and retrieval of file names. 
 (d) none of the above 
 

21. What is shell ? 
 (a) It is hardware component. (b) It is a part of compiler. 
 (c) It is a tool in CPU scheduling. (d) It is a command interpreter. 
 

22. Which of the following is most likely to use an embedded OS ? 
 (a) Computerized life-support system (b) Macintosh computer 
 (c) Desktop PC (d) None of the above 
 

23. In a GUI, the window that is currently in use is called as  
 (a) Top window (b) Active window 
 (c) Framed window (d) None of the above 
 

24. Multiprogramming is  
 (a) writing two or more programs at a time. 
 (b) using more than two programs to solve a problem. 
 (c) processing of two or more programs at the same time. 
 (d) None of the above 
 

25. An assembler in computer is a  
 (a) Program (b) Language (c) Hardware (d) Person 
 

26. Unix and its software are written in highlevel language 
 (a) C (b) PL/1 (c) Ada (d) None of these 
 

27. The operating system manages 
 (a) Memory (b) Processor 
 (c) Disk and I/O devices (d) All of the above 
 

28. Cryptographic technique is used in 
 (a) Pooling (b) Job scheduling (c) Protection (d) File management 
 

29. Modulation is the process of  
 (a) sending a file from one computer to another. 
 (b) converting digital signal to analog signal. 
 (c) converting analog signal to digital signal. 
 (d) echoing every character that is received. 
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16. ‹Ûú ________ •ÖÖê †®Öã¾ÖÖ¤üÛú Ûêú ºþ¯Ö ´Öë ¯ÖÏÖêÝÖÏÖ´Ö ŸÖ£ÖÖ ×›ü¾ÖÖ‡ÃÖ Ûêú ´Ö¬µÖ ×›ü¾ÖÖ‡ÃÖ Ûêú ¯ÖÏµÖÖêÝÖ ÆêüŸÖã ÛúÖµÖÔ Ûú¸üŸÖÖ Æîü … 
 (a) ‡®™ü¸ü¯ÖÏê™ü¸ü  (b) ×›ü¾ÖÖ‡ÃÖ ›ÒüÖ‡¾Ö¸ü  (c) Ûú´¯ÖÖ‡»Ö¸ü  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

17. Ã™üÖê¸êü•Ö ÛúÖ ¾ÖÆü ³ÖÖÝÖ •ÖÆüÖÑ Ûú´¯µÖæ™ü¸ü Ûêú ×¾Ö×³Ö®®Ö µÖæ×®Ö™üÖë Ûêú Ã¯Öß›ü Ûêú †®ŸÖ¸ü ÛúÖê Ûú´¯Ö®ÖÃÖê™ü Ûú¸ü®Öê Ûêú ×»Ö‹ ›üÖ™üÖ ÛúÖê Ã™üÖê¸ü 
Ûú¸ü®Öê Ûêú ×»Ö‹ ¯ÖÏµÖÖêÝÖ ÆüÖêŸÖÖ Æîü  

 (a) Ã´Öé×ŸÖ  (b) ‹ŒµÖæ´µÖæ»Öê™ü¸ü  (c) ²Ö±ú¸ü  (d) ‹›ÒêüÃÖ  
 

18. ˆÃÖ ¾µÖ¾ÖÃ£ÖÖ ÛúÖ ŒµÖÖ ®ÖÖ´Ö Æîü ×•ÖÃÖ´Öë Ûú‡Ô ÃÖê®™Òü»Ö ¯ÖÏÖêÃÖêØÃÖÝÖ µÖæ×®Ö™ü ‹Ûú Æüß Ã´Öé×ŸÖ ÛúÖ ¯ÖÏµÖÖêÝÖ Ûú¸üŸÖê Æïü ? 
 (a) ´Ö»™üß™üÖØÃÛúÝÖ  (b) ´Ö»™üß¯ÖÏÖêÝÖÏÖØ´ÖÝÖ  (c) ÛúÖÓÛú¸ëü™ü ¯ÖÏÖêÝÖÏÖØ´ÖÝÖ  (d) ´Ö»™üß¯ÖÏÖêÃÖêØÃÖÝÖ  
 

19. ¯Öê•Ö Ûúß ×®Ö¸ü®ŸÖ¸üŸÖÖ ´Öë ¹ýÛúÖ¾Ö™ü (fault) ÆüÖêŸÖß Æîü 
 (a) •Ö²Ö ¯Öê•Ö ´Öê´ÖÖê¸üß ´Öë ÆüÖê …  (b) •Ö²Ö ¯Öê•Ö ´Öê´ÖÖê¸üß ´Öë ®Ö ÆüÖê …   
 (c) •Ö²Ö ¯ÖÏÖêÃÖêÃÖ ²»ÖÖòŒ›ü Ã™êü™ü ´Öë •ÖÖŸÖÖ Æîü …  (d) •Ö²Ö ¯ÖÏÖêÃÖêÃÖ ŸÖîµÖÖ¸ü (Ready) Ã™êü™ü ´Öë ÆüÖêŸÖÖ Æîü …   
 

20. ‹Ûú ™Òüß Ûúß ²Ö®ÖÖ¾Ö™ü ÛúÖ ±úÖ‡»Ö ›üÖ‡¸êüŒ™ü¸üß ×ÃÖÃ™ü´Ö  
 (a) †Ö¾Ö¿µÖÛú ®ÖÆüà •Ö²Ö Æü´ÖÖ¸êü ¯ÖÖÃÖ »ÖÖÜÖÖë ±úÖ‡»Ö ÆüÖë  
  (b) ×¾Ö¾ÖÖ×¤üŸÖ †®ÖÖ¾Ö¿µÖÛú ÝÖãÞÖ  
 (c) ±úÖ‡»Ö Ûêú ®ÖÖ´ÖÖë ÛúÖê ÃÖã¸ü×õÖŸÖ †Öî¸ü œæÑüœÌü®Öê ÛúÖ †ÖÃÖÖ®Ö ŸÖ¸üßÛúÖ 
  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

21. ¿Öê»Ö ŒµÖÖ Æîü ? 
 (a) µÖÆü ‹Ûú ÆüÖ›Ôü¾ÖêµÖ¸ü ˆ¯ÖÛú¸üÞÖ Æîü …   (b) µÖÆü Ûú´¯ÖÖ‡»Ö¸ü ÛúÖ ‹Ûú ³ÖÖÝÖ Æîü …   
 (c) µÖÆü ÃÖß.¯Öß.µÖæ. ×¿Ö›ËüµÖæØ»ÖÝÖ ÛúÖ ™æü»Ö Æîü …   (d) µÖÆü ‹Ûú Ûú´ÖÖÞ›ü ‡Ó™ü¸ü¯ÖÏê™ü¸ü Æîü …   
 

22. ×®Ö´®Ö ´Öë ÃÖê ×ÛúÃÖê ´ÖãÜµÖŸÖ: ‡´²Öê›êü›ü †Öò¯Ö¸êüØ™üÝÖ ×ÃÖÃ™ü´Ö Ûúß ŸÖ¸üÆü ¯ÖÏµÖãŒŸÖ ×ÛúµÖÖ •ÖÖŸÖÖ Æîü ? 
 (a) Ûú´¯µÖæ™ü¸üßÛéúŸÖ »ÖÖ‡±ú ÃÖ¯ÖÖê™Ôü ×ÃÖÃ™ü´Ö  (b) ´ÖêÃÖà-™üÖê¿Ö Ûú´¯µÖæ™ü¸ü  
 (c) ›êüÃÛú™üÖò¯Ö ¯Öß.ÃÖß.  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

23. •Öß.µÖæ.†Ö‡Ô. ´Öë, •ÖÖê ×¾Ö®›üÖê ŸÖŸÃÖ´ÖµÖ ¯ÖÏµÖÖêÝÖ ´Öë ÆüÖêŸÖß Æîü, ˆÃÖê ÛúÆüŸÖê Æïü 
 (a) ™üÖò¯Ö ×¾Ö®›üÖê  (b) ‹Œ™üß¾Ö ×¾Ö®›üÖê  (c) ±Ïêú´›ü ×¾Ö®›üÖê  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

24. ´Ö»™üß¯ÖÏÖêÝÖÏÖØ´ÖÝÖ Æîü  
 (a) ‹Ûú Æüß ÃÖ´ÖµÖ ¤üÖê µÖÖ ˆÃÖÃÖê †×¬ÖÛú ¯ÖÏÖêÝÖÏÖ´Ö ×»ÖÜÖ®ÖÖ … 
  (b) ×ÛúÃÖß ÃÖ´ÖÃµÖÖ Ûêú Æü»Ö ÆêüŸÖã ¤üÖê ÃÖê †×¬ÖÛú ¯ÖÏÖêÝÖÏÖ´Ö ¯ÖÏµÖÖêÝÖ Ûú¸ü®ÖÖ …   
 (c) ‹Ûú Æüß ÃÖ´ÖµÖ ¤üÖê µÖÖ ˆÃÖÃÖê †×¬ÖÛú ¯ÖÏÖêÝÖÏÖ´Ö Ûúß ¯ÖÏÖêÃÖêØÃÖÝÖ Ûú¸ü®ÖÖ … 
  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà … 
 

25. Ûú´¯µÖæ™ü¸ü ´Öë ‹ÃÖê´²Ö»Ö¸ü Æîü 
 (a) ¯ÖÏÖêÝÖÏÖ´Ö  (b) ³ÖÖÂÖÖ  (c) ÆüÖ›Ôü¾ÖêµÖ¸ü  (d) ¾µÖ×ŒŸÖ  
 

26. µÖæ×®ÖŒÃÖ ŸÖ£ÖÖ ‡ÃÖÛêú ÃÖÖò°™ü¾ÖêµÖ¸ü ×•ÖÃÖ ˆ““Ö ÃŸÖ¸üßµÖ ³ÖÖÂÖÖ ´Öë ×»ÖÜÖê Æïü, ¾ÖÆü Æîü  
 (a) ÃÖß  (b) ¯Öß.‹»Ö./1  (c) ‹›üÖ  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

27. †Öò¯Ö¸êüØ™üÝÖ ×ÃÖÃ™ü´Ö ¾µÖ¾Ö×Ã£ÖŸÖ Ûú¸üŸÖÖ Æîü  
 (a) ´Öê´ÖÖê¸üß  (b) ¯ÖÏÖêÃÖêÃÖ¸ü  
 (c) ×›üÃÛú ‹¾ÖÓ †Ö‡Ô/†Öê ×›ü¾ÖÖ‡ÃÖêÃÖ  (d) ˆ¯Ö¸üÖêŒŸÖ ÃÖ³Öß  
 

28. ×ÛÎú¯™üÖêÝÖÏÖ×±úÛú ŸÖÛú®ÖßÛú ×®Ö´®Ö ´Öë ¯ÖÏµÖãŒŸÖ ÆüÖêŸÖß Æîü : 
 (a) ¯ÖæØ»ÖÝÖ  (b) •ÖÖò²Ö ×¿Ö›ËüµÖæØ»ÖÝÖ  (c) ¯ÖÏÖê™êüŒ¿Ö®Ö  (d) ±úÖ‡»Ö ´Öî®Öê•Ö´Öë™ü  
 

29. ´ÖÖò›ËüµÖæ»Öê¿Ö®Ö ‹Ûú ¯ÖÏ×ÛÎúµÖÖ Æîü  
 (a) ‹Ûú ±úÖ‡»Ö ÛúÖê ‹Ûú Ûú´¯µÖæ™ü¸ü ÃÖê ¤æüÃÖ¸êü Ûú´¯µÖæ™ü¸ü ¯Ö¸ü ³Öê•Ö®ÖÖ … 
  (b) ×›ü×•Ö™ü»Ö ×ÃÖÝÖ®Ö»Ö ÛúÖê ‹®ÖÖ»ÖÖòÝÖ ×ÃÖÝÖ®Ö»Ö ´Öë ¯Ö×¸ü¾ÖÙŸÖŸÖ Ûú¸ü®ÖÖ …  
 (c) ‹®ÖÖ»ÖÖòÝÖ ×ÃÖÝÖ®Ö»Ö ÛúÖê ×›ü×•Ö™ü»Ö ×ÃÖÝÖ®Ö»Ö ´Öë ¯Ö×¸ü¾ÖÙŸÖŸÖ Ûú¸ü®ÖÖ …  
  (d) ¯ÖÏŸµÖêÛú ¯ÖÏÖ¯ŸÖ Ûîú¸êüŒ™ü¸ü Ûúß ‡ÛúÖê‡ÓÝÖ (Echoing) Ûú¸ü®ÖÖ …   
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30. FDDI is a  
 (a) Ring Network (b) Star Network 
 (c) Mess Network (d) Bus Based Network 
 

31. Junk E-mail is also called  
 (a) Spam (b) Spoof (c) Sniffer script (d) Spool 
 

32. Data transfer rate in modems is measured in 
 (a) Bits per minute (b) Bits per second 
 (c) Bandwidth (d) None of the above 
 

33. Which of the following wired transmission media is the fastest ? 
 (a) Twisted pair (b) Coaxial cable 
 (c) Optical fiber (d) None of the above 
 

34. When data is sent during set time periods, what do you call the transmission mode ? 
 (a) Synchronous (b) Asynchronous 
 (c) Protocol (d) None of the above 
 

35. Which of the following networking solution is suitable for networking within a building ? 
 (a) WAN (b) LAN (c) MAN (d) None of these 
 

36. IRC stands for 
 (a) Internet Real Time Communication (b) Internet Relay Chat 
 (c) Internet Real-Time Chat (d) None of the above 
 

37. Devices on one network can communicate with devices on another network via a  
 (a) File Server (b) Utility Server (c) Printer Server (d) Gateway 
 

38. CSMA/CD 
 (a) is a protocol (b) is used in  IEEE 802.3 (Ethernet) 
 (c) both (a) and (b) (d) None of the above  
 

39. With electronic mail you can do which of the following : 
 (a) send and read mail (b) delete, reply to, or forward 
 (c) delete some one else’s mail (d) both (a) and (b) 
 

40. Which service is used on internet to exchange files ? 
 (a) Telnet (b) Gopher (c) FTP (d) SP 
 

41. Two commonly used web browser are internet explorer and  
 (a) Netscape Network (b) Mozilla Firefox 
 (c) Network Navigator (d) Internet Navigator 
 

42. The first network that planted the seeds of Internet was 
 (a) ARPANET (b) NSFNET (c) VNET (d) INET 
 

43. The server on the Internet is also known as  
 (a) Repeater (b) Gateway (c) Host (d) None of these 
 

44. What does DNS stands for ? 
 (a) Data Naming Service (b) Domain Name System 
 (c) Data Numeric System (d) Decentralized Naming System 
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30. ‹±ú.›üß.›üß.†Ö‡Ô. Æîü 
 (a) Ø¸üÝÖ ®Öê™ü¾ÖÛÔú  (b) Ã™üÖ¸ü ®Öê™ü¾ÖÛÔú  (c) ´Öê¿Ö ®Öê™ü¾ÖÛÔú  (d) ²ÖÃÖ †Ö¬ÖÖ×¸üŸÖ ®Öê™ü¾ÖÛÔú  
 

31. •ÖÓÛú ‡Ô´Öê»Ö ÛúÖê µÖÆü ³Öß ÛúÆüÖ •ÖÖŸÖÖ Æîü   
 (a) Ã¯Öî´Ö  (b) Ã¯Öæ±ú  (c) Ã®Öß±ú¸ü ×ÃÛÎú¯™ü  (d) Ã¯Öæ»Ö  
 

32. ´ÖÖò›êü´Ö ´Öë ›üÖ™üÖ Ã£ÖÖ®ÖÖÓŸÖ¸üÞÖ ¤ü¸ü ´ÖÖ¯Öß •ÖÖŸÖß Æîü 
 (a) ×²Ö™ËüÃÖ ¯ÖÏ×ŸÖ ×´Ö®Ö™ü ´Öë  (b) ×²Ö™ËüÃÖ ¯ÖÏ×ŸÖ ÃÖêÛúÞ›ü ´Öë   
 (c) ²Öï›ü×¾Ö›Ëü£Ö ´Öë  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

33. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ÃÖÖ ¾ÖÖµÖ¸ü ™ÒüÖÓÃÖ×´Ö¿Ö®Ö ´Öß×›üµÖÖ ÃÖ²ÖÃÖê ŸÖß¾ÖÎ Æîü ? 
 (a) ™Ëü¾ÖßÃ™êü›ü ¯ÖêµÖ¸ü  (b) ÛúÖê‹×ŒÃÖµÖ»Ö Ûêú×²Ö»Ö  
 (c) †Öò¯™üßÛú»Ö ±úÖ‡²Ö¸ü  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

34. •Ö²Ö ›üÖ™üÖ ×®Ö¬ÖÖÔ×¸üŸÖ ÃÖ´ÖµÖ †ÓŸÖ¸üÖ»Ö ´Öë ³Öê•ÖÖ •ÖÖŸÖÖ Æîü, ŸÖÖê ‡ÃÖ ™ÒüÖÓÃÖ×´Ö¿Ö®Ö ´ÖÖò›ü ÛúÖê †Ö¯Ö ŒµÖÖ ÛúÆüŸÖê Æïü ? 
 (a) ×ÃÖ®ÛÎúÖê®ÖÃÖ  (b) ‹×ÃÖ®ÛÎúÖê®ÖÃÖ  (c) ¯ÖÏÖê™üÖêÛúÖò»Ö  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

35. ×ÛúÃÖß ‡´ÖÖ¸üŸÖ ´Öë ®Öê™ü¾ÖÚÛúÝÖ Ûêú ×»Ö‹ ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ÃÖß ®Öê™ü¾ÖÚÛúÝÖ ˆ¯ÖµÖãŒŸÖ Æîü ? 
 (a) ¾Öî®Ö (WAN) (b) »Öî®Ö (LAN) (c) ´Öî®Ö (MAN)  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

36. †Ö‡Ô.†Ö¸ü.ÃÖß. (IRC) ÛúÖ ŸÖÖŸ¯ÖµÖÔ Æîü 
 (a) ‡®™ü¸ü®Öê™ü ¸üßµÖ»Ö-™üÖ‡´Ö Ûú´µÖæ×®ÖÛêú¿Ö®Ö  (b) ‡®™ü¸ü®Öê™ü ×¸ü»Öê “Öî™ü  
 (c) ‡®™ü¸ü®Öê™ü ¸üßµÖ»Ö-™üÖ‡´Ö “Öî™ü  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

37. ‹Ûú ®Öê™ü¾ÖÛÔú ÛúÖ ˆ¯ÖÛú¸üÞÖ ¤æüÃÖ¸êü ®Öê™ü¾ÖÛÔú Ûêú ˆ¯ÖÛú¸üÞÖ ÃÖê ×®Ö´®Ö Ûêú «üÖ¸üÖ ÃÖÓ“ÖÖ¸ü Ûú¸üŸÖÖ Æîü : 
 (a) ±úÖ‡»Ö ÃÖ¾ÖÔ¸ü  (b) µÖæ×™ü×»Ö™üß ÃÖ¾ÖÔ¸ü  (c) Ø¯ÖÏ™ü¸ü ÃÖ¾ÖÔ¸ü  (d) ÝÖê™ü¾Öê  
 

38. ÃÖß.‹ÃÖ.‹´Ö.‹./ÃÖß›üß 
 (a) ‹Ûú ¯ÖÏÖê™üÖêÛúÖò»Ö Æîü …   (b) IEEE802.3(‡£Ö¸ü®Öê™ü) ´Öë ¯ÖÏµÖãŒŸÖ ÆüÖêŸÖÖ Æîü …   
 (c) ¤üÖê®ÖÖë (a) ¾Ö (b)  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

39. ‡»ÖêŒ™ÒüÖò×®ÖÛú ´Öê»Ö Ûêú «üÖ¸üÖ †Ö¯Ö ×®Ö´®Ö ´Öë ÃÖê ŒµÖÖ Ûú¸ü ÃÖÛúŸÖê ÆüÖê ? 
 (a) ´Öê»Ö ³Öê•Ö®ÖÖ †Öî¸ü ¯ÖœÌü®ÖÖ … (b) ÜÖŸ´Ö Ûú¸ü®ÖÖ, •Ö¾ÖÖ²Ö ¤êü®ÖÖ µÖÖ †ÝÖÏÃÖÖ×¸üŸÖ Ûú¸ü®ÖÖ … 
 (c) ×ÛúÃÖß ¤æüÃÖ¸êü Ûúß ´Öê»Ö ÜÖŸ´Ö Ûú¸ü®ÖÖ …   (d) ˆ¯Ö¸üÖêŒŸÖ ¤üÖê®ÖÖë (a) ŸÖ£ÖÖ (b) 
 

40. ±úÖ‡»Ö Ûêú †¤ü»ÖÖ-²Ö¤ü»Öß ÆêüŸÖã ‡®™ü̧ ü®Öê™ü ¯Ö¸ü ×ÛúÃÖ ÃÖê¾ÖÖ ÛúÖ ¯ÖÏµÖÖêÝÖ ÆüÖêŸÖÖ Æîü ? 
 (a) ™êü»Ö®Öê™ü  (b) ÝÖÖê±ú¸ü  (c) ‹±ú.™üß.¯Öß.  (d) ‹ÃÖ.¯Öß.  
 

41. ÃÖÖ´ÖÖ®µÖŸÖ: ¯ÖÏµÖãŒŸÖ ×Ûú‹ •ÖÖ®Öê ¾ÖÖ»Öê ¤üÖê ¾Öê²Ö ²ÖÎÖˆ•Ö¸ü ‡®™ü¸ü®Öê™ü ‹ŒÃÖ¯»ÖÖê»Ö¸ü ‹¾ÖÓ _______ Æîü … 
 (a) ®Öê™ üÃÛêú¯Ö ®Öê™ü¾ÖÛÔú  (b) ´ÖÖê×•ÖÌ»ÖÖ ±úÖµÖ¸ü±úÖòŒÃÖ  
 (c) ®Öê™ü¾ÖÛÔú ®Öî×¾ÖÝÖê™ü¸ü  (d) ‡®™ü¸ü®Öê™ü ®Öî×¾ÖÝÖê™ü¸ü  
 

42. ‡®™ü¸ü®Öê™ü ÛúÖ ²Öß•Ö ¸üÖê×¯ÖŸÖ Ûú¸ü®Öê ¾ÖÖ»ÖÖ ¯ÖÆü»ÖÖ ®Öê™ü¾ÖÛÔú £ÖÖ  
 (a) †¯ÖÖÔ®Öê™ü  (b) ‹®Ö.‹ÃÖ.‹±ú. ®Öê™ü  (c) ¾Öß ®Öê™ü  (d) †Ö‡Ô ®Öê™ü  
 

43. ‡®™ü¸ü®Öê™ü ¯Ö¸ü ÃÖ¾ÖÔ¸ü ÛúÖê ×®Ö´®Ö ®ÖÖ´Ö ÃÖê ³Öß •ÖÖ®ÖÖ •ÖÖŸÖÖ Æîü : 
 (a) ×¸ü¯Öß™ü¸ü  (b) ÝÖê™ü¾Öê  (c) ÆüÖêÃ™ü  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

44. ›üß.‹®Ö.‹ÃÖ. (DNS) ÛúÖ ŒµÖÖ ŸÖÖŸ¯ÖµÖÔ Æîü ? 
 (a) ›üÖ™üÖ ®ÖêØ´ÖÝÖ ÃÖÙ¾ÖÃÖ  (b) ›üÖê´Öê®Ö ®Öê´Ö ×ÃÖÃ™ü´Ö  
 (c) ›üÖ™üÖ ®µÖæ´Öê×¸üÛú ×ÃÖÃ™ü´Ö  (d) ›üßÃÖê®™Òü»ÖÖ‡•›ü ®ÖêØ´ÖÝÖ ×ÃÖÃ™ü´Ö  
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45. POP is referred to as  
 (a) Primary Offline Protocol (b) Public Object Protocol 
 (c) Post Office Protocol (d) None of the above  
 
46. The language used in application programs to request data from DBMS is referred to as  
 (a) DML (b) DDL (c) DCL (d) All of these 
 
47. Which of the following is not an RDBMS ? 
 (a) Oracle (b) Sybase (c) Microsoft Word (d) Ingres 
 
48. The order of logical operations in SQL is  
 (a) AND, OR, NOT (b) NOT, AND, OR 
 (c) OR, NOT, AND (d) None of the above 
 
49. A file consist of  
 (a) databases and fields (b) fields and sorts 
 (c) records and sorts (d) fields and records 
 
50. The distinguishable parts of a record are called 
 (a) Data (b) Files (c) Fields (d) All of these 
 
51. An SQL command should be terminated with a  
 (a) : (b) ; (c) – (d) ? 
 
52. In relational schema, each tuple is divided into fields is called  
 (a) Relations (b) Domains (c) Queries (d) All of these 
 
53. The command used to compare the files is known as  
 (a) du (b) comp (c) ccp (d) cmp 
 
54. The column of a table is referred to as the  
 (a) tuple (b) attribute (c) entity (d) degree 
 
55. Multimedia elements are  
 (a) Text and picture (b) Animation 
 (c) Movie, video and sound (d) All of the above 
 
56. TIFF stands for 
 (a) Tagged Image File Format (b) Template Image File Format 
 (c) Temporary Interchange File Format (d) None of the above 
 

57. Which technique is used to blend two or more images to form a new image ? 
 (a) Rendering (b) Wrapping (c) Morphing (d) Animating 
 
58. A _______ has length, width, tone and texture. 
 (a) Point (b) Colour (c) Line (d) None of these 
 

59. Periodically adding, changing and deleting file records is called file  
 (a) Updating (b) Upgrading (c) Restructuring (d) None of these 
 
60. Good quality video and higher resolution image is achieved through 
 (a) Quick time (b) MPEG (c) AVI (d)  None of these 
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45. ¯Öß.†Öê.¯Öß. (POP) ÛúÖ ŸÖÖŸ¯ÖµÖÔ Æîü 
 (a) ¯ÖÏÖ‡´Ö¸üß †Öò±ú»ÖÖ‡®Ö ¯ÖÏÖê™üÖêÛúÖò»Ö  (b) ¯Ö×²»ÖÛú †Öò²•ÖêŒ™ü ¯ÖÏÖê™üÖêÛúÖò»Ö  
 (c) ¯ÖÖêÃ™ü †Öò×±úÃÖ ¯ÖÏÖê™üÖêÛúÖò»Ö  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

46. ›üß.²Öß.‹´Ö.‹ÃÖ. ÃÖê ›üÖ™üÖ ¯ÖÏÖ¯ŸÖü Ûú¸ü®Öê Ûêú ×»Ö‹ ¯ÖÏµÖÖêÝÖÖ£ÖÔ ¯ÖÏÖêÝÖÏÖ´Ö ´Öë ³ÖÖÂÖÖ ¯ÖÏµÖãŒŸÖ Ûúß •ÖÖŸÖß Æîü, ÛúÆü»ÖÖŸÖß Æîü  
 (a) ›üß.‹´Ö.‹»Ö.  (b) ›üß.›üß.‹»Ö.  
 (c) ›üß.ÃÖß.‹»Ö.  (d) ˆ¯Ö¸üÖêŒŸÖ ÃÖ³Öß   
 

47. ×®Ö´®Ö×»Ö×ÜÖŸÖ ´Öë ÃÖê ÛúÖî®Ö †Ö¸ü.›üß.²Öß.‹´Ö.‹ÃÖ. (RDBMS) ®ÖÆüà Æîü ? 
 (a) †Öò¸êüÛú»Ö  (b) ÃÖÖ‡²ÖêÃÖ  (c) ´ÖÖ‡ÛÎúÖêÃÖÖò°™ü ¾Ö›Ôü  (d) ‡®ÖÝÖÏêÃÖ  
 

48. ‹ÃÖ.ŒµÖæ.‹»Ö. (SQL) ´Öë »ÖÖò×•ÖÛú»Ö †Öò¯Ö¸êü¿Ö®Ö ÛúÖ ÛÎú´Ö Æîü  
 (a) AND, OR, NOT  (b) NOT, AND, OR  
 (c) OR, NOT, AND  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

49. ±úÖ‡»Ö ´Öë ÆüÖêŸÖÖ Æîü  
 (a) ›üÖ™üÖ²ÖêÃÖêÃÖ †Öî¸ü ×±ú»›ËüÃÖ  (b) ×±ú»›ËüÃÖ †Öî¸ü ÃÖÖò™ÔËüÃÖ   
 (c) ×¸üÛúÖò›ÔËüÃÖ †Öî¸ü ÃÖÖò™ÔËüÃÖ   (d) ×±ú»›ËüÃÖ †Öî¸ü ×¸üÛúÖò›ÔËüÃÖ   
 

50. ×¸üÛúÖò›Ôü Ûêú †»ÖÝÖ ×Ûú‹ •ÖÖ ÃÖÛú®Öê ¾ÖÖ»Öê ¯ÖÖ™ÔËüÃÖ ÛúÖê ÛúÆüŸÖê Æïü  
 (a) ›üÖ™üÖ  (b) ±úÖ‡»ÃÖ  (c) ×±ú»›ËüÃÖ  (d) µÖê ÃÖ³Öß  
 

51. ‹Ûú ‹ÃÖ.ŒµÖæ.‹»Ö. (SQL) ×®Ö´®Ö ÃÖê ÜÖŸ´Ö ÆüÖê®Öß “ÖÖ×Æü‹ : 
 (a) :  (b) ;  (c) –  (d) ?  
 

52. ×¸ü»Öê¿Ö®Ö»Ö ÃÛúß´ÖÖ ´Öë, ¯ÖÏŸµÖêÛú ™ü¯Ö»Ö (Tuple) ÛúÖê ×±ú»›ËüÃÖ ´Öë ²ÖÖÑ™ü®ÖÖ ÛúÆü»ÖÖŸÖÖ Æîü  
 (a) ×¸ü»Öê¿Ö®ÃÖ  (b) ›üÖê´Öê®ÃÖ  (c) Œ¾Öê¸üß•Ö  (d) µÖê ÃÖ³Öß  
 

53. ±úÖ‡»ÃÖ Ûúß ŸÖã»Ö®ÖÖ Ûú¸ü®Öê ¾ÖÖ»ÖÖ ÃÖ´ÖÖ¤êü¿Ö •ÖÖ®ÖÖ •ÖÖŸÖÖ Æîü  
 (a) du  (b) comp  (c) ccp  (d) cmp  
 

54. ‹Ûú ŸÖÖ×»ÖÛúÖ ÛúÖ ÛúÖò»Ö´Ö ¯ÖÏ¤üÙ¿ÖŸÖ Ûú¸üŸÖÖ Æîü  
 (a) ™ü¯Ö»Ö  (b) ‹™Òüß²µÖæ™ü  (c) ‹®Ö×™ü™üß  (d) ×›üÝÖÏß  
 

55. ´Ö»™üß´Öß×›üµÖÖ ŸÖ¢¾Ö Æïü 
 (a) ™êüŒÃ™ü †Öî¸ü ×¯ÖŒ“Ö¸ü  (b) ‹®Öß´Öê¿Ö®Ö  
 (c) ´Öæ¾Öß, ¾Öß×›üµÖÖê †Öî¸ü ÃÖÖˆÞ›ü  (d) ˆ¯Ö¸üÖêŒŸÖ ÃÖ³Öß  
 

56. ™üß.†Ö‡Ô.‹±ú.‹±ú. (TIFF) ÛúÖ ŸÖÖŸ¯ÖµÖÔ Æîü  
 (a) ™îüÝ›ü ‡´Öê•Ö ±úÖ‡»Ö ±úÖò´Öì™ü  (b) ™êü´¯»Öê™ü ‡´Öê•Ö ±úÖ‡»Ö ±úÖò´Öì™ü  
 (c) ™êü´¯ÖÖê¸êü¸üß ‡®™ü¸ü“Öï•Ö ±úÖ‡»Ö ±úÖò´Öì™ü  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

57. ¤üÖê µÖÖ †×¬ÖÛú ×“Ö¡ÖÖë ÛúÖê ×´Ö»ÖÖÛú¸ü ‹Ûú ®ÖµÖÖ ×“Ö¡Ö ²Ö®ÖÖ®Öê Ûêú ×»Ö‹ ÛúÖî®Ö ÃÖÖ ŸÖ¸üßÛúÖ ¯ÖÏµÖÖêÝÖ ×ÛúµÖÖ •ÖÖŸÖÖ Æîü ? 
 (a) ¸ëü›üØ¸üÝÖ  (b) ¸îüØ¯ÖÝÖ  (c) ´ÖÖòÚ±úÝÖ  (d) ‹®Öß´ÖêØ™üÝÖ  
 

58. ‹Ûú ________ ´Öë »Ö´²ÖÖ‡Ô, “ÖÖî›ÌüÖ‡Ô, ™üÖê®Ö †Öî¸ü ™êüŒÃ“Ö¸ü (Texture) ÆüÖêŸÖÖ Æîü … 
 (a) ¯¾ÖÖò‡Ó™ü  (b) Ûú»Ö¸ü  (c) »ÖÖ‡®Ö  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

59. ÃÖ´ÖÖ®Ö ÃÖ´ÖµÖ †®ŸÖ¸üÖ»Ö ¯Ö¸ü ±úÖ‡»Ö ×¸üÛúÖò›ÔËüÃÖ ÛúÖê •ÖÖê›Ìü®ÖÖ, ²Ö¤ü»Ö®ÖÖ ‹¾ÖÓ ÜÖŸ´Ö Ûú¸ü®ÖÖ ±úÖ‡»Ö ______ ÛúÆü»ÖÖŸÖÖ Æîü … 
 (a) †¯Ö›êüØ™üÝÖ  (b) †¯ÖÝÖÏêØ›üÝÖ  
 (c) ¸üß-Ã™ÒüŒ“ÖØ¸üÝÖ  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

60. †“”ûß ÝÖãÞÖ¾Ö¢ÖÖ Ûúß ¾Öß×›üµÖÖê ŸÖ£ÖÖ ˆ““Ö ¸üß•ÖÖê»Öã¿Ö®Ö ‡´Öê•Ö ‡ÃÖÛêú «üÖ¸üÖ ¯ÖÏÖ¯ŸÖ ÆüÖêŸÖß Æîü : 
 (a) ×Œ¾ÖÛú ™üÖ‡´Ö  (b) ‹´Ö.¯Öß.‡Ô.•Öß.  (c) ‹.¾Öß.†Ö‡Ô.  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
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PART – II 
61. A menu driven system 
 (a) is required only for online system. 
 (b) increases the operator’s work. 
 (c) can be used only by computer operator. 
 (d) presents options and allows the user to make selections. 
 

62. To select a window as active using mouse, simply click on ________ portion of the 
window. 

 (a) top (b) bottom (c) any (d) None of these 
 

63. Which of the following shows icons for all servers and workstations in your network ? 
 (a) Network Neighbourhood (b) My Document 
 (c) Recycle Bin (d) None of the above 
 

64. Whenever you view or manage files and folders, then you will use a program called 
_____. 

 (a) Internet Explorer (b) Windows Explorer 
 (c) Recycle Bin (d) None of the above 
 

65. Windows 98 was develop in  
 (a) 1994 (b) 1998 (c) 2001 (d) 2004 
 

66. All the deleted file go to  
 (a) Recycle Bin (b) Taskbar (c) Tool bar  (d) My Computer  
 

67. Windows is  
 (a) Hardware (b) Modem (c) Input Device (d) Operating System 
 

68. Which of the following is not an operating system ? 
 (a) DOS (b) UNIX (c) LINUX (d)  MS-Office 
 

69. GUI stands for  
 (a) Gnutella Universal Interface (b) Graphical User Interface 
 (c) Graphic Universal Information (d) General Utility Interface 
 

70. The Recycle Bin stores deleted items until  
 (a) another user logs on (b) the computer is shutdown 
 (c) the end of the day (d) you empty it 
 

71. Windows Me operating stands for  
 (a) Windows My Edition (b) Windows 98 
 (c) Windows Millennium Edition (d) None of the above 
 

72. Which button can be used to switch the active window ? 
 (a) Start (b) Documents (c) Taskbar (d) None of these 
 

73. The process of moving from one open window to another is called  
 (a) Task switching (b) System call 
 (c) Moving (d) None of these 
 

74. Which is not an operating system task ? 
 (a) Document Editing (b) Managing Memory 
 (c) Allocating Processor (d) Loading Programs 
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³ÖÖÝÖ ³ÖÖÝÖ ³ÖÖÝÖ ³ÖÖÝÖ ----    IIIIIIII 
61. ¯ÖÏÃÖæ“Öß ÃÖÓ“ÖÖ×»ÖŸÖ ŸÖÓ¡Ö 
 (a) Ûêú¾Ö»Ö †Öò®Ö»ÖÖ‡®Ö ŸÖÓ¡Ö Ûêú ×»Ö‹ †Ö¾Ö¿µÖÛú Æîü …  
   (b) ¯ÖÏ“ÖÖ»ÖÛú ÛúÖ ÛúÖµÖÔ ²ÖœÌüÖŸÖÖ Æîü …   
 (c) Ûêú¾Ö»Ö Ûú´¯µÖæ™ü¸ü ¯ÖÏ“ÖÖ»ÖÛú «üÖ¸üÖ ¯ÖÏµÖãŒŸÖ ÆüÖê ÃÖÛúŸÖÖ Æîü …  
  (d) ×¾ÖÛú»¯Ö ¯ÖÏ¤üÙ¿ÖŸÖ Ûú¸üŸÖÖ Æîü ‹¾ÖÓ ˆ¯ÖµÖÖêŒŸÖÖ ÛúÖê “ÖûµÖ®Ö Ûêú ×»Ö‹ †®Öã´Ö×ŸÖ ¯ÖÏ¤üÖ®Ö Ûú¸üŸÖÖ Æîü …  
 

62. Ø¾Ö›üÖê•Ö ÛúÖê ÃÖ×ÛÎúµÖ ºþ¯Ö ´Öë “ÖµÖ®Ö ÆêüŸÖã ´ÖÖˆÃÖ ÛúÖê Ø¾Ö›üÖê•Ö Ûêú _______ ³ÖÖÝÖ ´Öë ÃÖÖ¬ÖÖ¸üÞÖŸÖµÖÖ ×Œ»ÖÛú Ûú¸üŸÖê Æïü …  
 (a) ¿ÖßÂÖÔ  (b) †Ö¬ÖÖ¸ü  
 (c) ×ÛúÃÖß ³Öß  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

63. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö †Ö¯ÖÛêú ®Öê™ü¾ÖÛÔú ´Öë ÃÖ³Öß ÃÖ¾ÖÔ¸ü ‹¾ÖÓ ¾ÖÛÔúÃ™êü¿Ö®ÖÖë Ûêú ×»Ö‹ †Ö‡Ûú®Ö (icon) ¤ü¿ÖÖÔŸÖÖ Æîü ? 
 (a) ®Öê™ü¾ÖÛÔú ®Öê²Ö¸üÆãü›ü  (b) ´ÖÖ‡Ô ›üÖòŒµÖæ´Öë™ü  
 (c) ×¸üÃÖÖ‡×Ûú»Ö ×²Ö®Ö  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

64. •Ö²Ö ³Öß †Ö¯Ö ±úÖ‡»Ö ŸÖ£ÖÖ ±úÖê»›ü¸üÖë ÛúÖê ¤êüÜÖŸÖê Æïü µÖÖ ¯ÖÏ²Ö®¬Ö®Ö Ûú¸üŸÖê Æïü, ŸÖÖê ×•ÖÃÖ ¯ÖÏÖêÝÖÏÖ´Ö ÛúÖ †Ö¯Ö ¯ÖÏµÖÖêÝÖ Ûú¸üŸÖê Æïü ¾ÖÆü 
ÛúÆü»ÖÖŸÖÖ Æîü  

 (a) ‡®™ü¸ü®Öê™ü ‹ŒÃÖ¯»ÖÖê¸ü¸ü  (b) ×¾Ö®›üÖê•Ö ‹ŒÃÖ¯»ÖÖê¸ü¸ü  
 (c) ×¸üÃÖÖ‡×Ûú»Ö ×²Ö®Ö  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

65. ×¾Ö®›üÖê•Ö 98 ÛúÖ ×¾ÖÛúÖÃÖ _______ ´Öë Æãü†Ö …  
 (a) 1994  (b) 1998  (c) 2001  (d) 2004  
 

66. ÃÖ³Öß ×›ü»Öß™ü Ûúß Æãü‡Ô ±úÖ‡»Ö ×®Ö´®Ö ´Öë •ÖÖŸÖß Æîü : 
 (a) ×¸üÃÖÖ‡×Ûú»Ö ×²Ö®Ö  (b) ™üÖÃÛú²ÖÖ¸ü  (c) ™æü»Ö²ÖÖ¸ü  (d) ´ÖÖ‡Ô Ûú´¯µÖæ™ü¸ü  
 

67. ×¾Ö®›üÖê•Ö Æîü 
 (a) ÆüÖ›Ôü¾ÖêµÖ¸ü  (b) ´ÖÖò›êüü´Ö  (c) ‡®Ö¯Öã™ü ×›ü¾ÖÖ‡ÃÖ  (d) †Öò¯Ö¸êüØ™üÝÖ ×ÃÖÃ™ü´Ö  
 

68. ×®Ö´®Ö×»Ö×ÜÖŸÖ ´Öë ÃÖê ÛúÖî®Ö †Öò¯Ö¸êüØ™üÝÖ ×ÃÖÃ™ü´Ö ®ÖÆüà Æîü ? 
 (a) ›üÖòÃÖ  (b) µÖæ×®ÖŒÃÖ  (c) »ÖÖ‡®ÖŒÃÖ  (d) ‹´Ö.‹ÃÖ.-†Öò×±úÃÖ  
 

69. •Öß.µÖæ.†Ö‡Ô. (GUI) ÛúÖ ŸÖÖŸ¯ÖµÖÔ Æîü  
 (a) Ý®Öã™êü»ÖÖ µÖæ×®Ö¾ÖÃÖÔ»Ö ‡®™ü¸ü±êúÃÖ  (b) ÝÖÏÖ×±úÛú»Ö µÖæ•Ö¸ü ‡®™ü¸ü±êúÃÖ  
 (c) ÝÖÏÖ×±úÛú µÖæ×®Ö¾ÖÃÖÔ»Ö ‡®±úÖò´Öì¿Ö®Ö  (d) •Ö®Ö¸ü»Ö µÖæ×™ü×»Ö™üß ‡®™ü¸ü±êúÃÖ  
 

70. _______ ŸÖÛú ×¸üÃÖÖ‡×Ûú»Ö ×²Ö®Ö ×›ü»Öß™êü›ü †Ö‡™ü´ÃÖ Ã™üÖê¸ü Ûú¸üŸÖÖ Æîü … 
 (a) ¤æüÃÖ¸êü µÖæ•Ö¸ü Ûêú »ÖÖÝÖ †Öò®Ö Ûú¸ü®Öê  (b) Ûú´¯µÖæ™ü¸ü ²ÖÓ¤ü ÆüÖê®Öê  
 (c) ×¤ü¾ÖÃÖÖÓŸÖ  (d) †Ö¯ÖÛêú ÜÖÖ»Öß Ûú¸ü®Öê   
 

71. ×¾Ö®›üÖê•Ö ‹´Ö.‡Ô. †Öò¯Ö¸êüØ™üÝÖ ×ÃÖÃ™ü´Ö ÛúÖ ´ÖŸÖ»Ö²Ö Æîü  
 (a) ×¾Ö®›üÖê•Ö ´ÖÖ‡Ô ‹×›ü¿Ö®Ö  (b) ×¾Ö®›üÖê•Ö 98  
 (c) ×¾Ö®›üÖê•Ö ×´Ö»Öê×®ÖµÖ´Ö ‹×›ü¿Ö®Ö  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

72. ‹Œ™üß¾Ö ×¾Ö®›üÖê ÛúÖê Ã¾Öß“Ö Ûú¸ü®Öê Ûêú ×»Ö‹ ×ÛúÃÖ ²Ö™ü®Ö ÛúÖ ¯ÖÏµÖÖêÝÖ ×ÛúµÖÖ •ÖÖ ÃÖÛúŸÖÖ Æîü ? 
 (a) Ã™üÖ™Ôü  (b) ›üÖòŒµÖæ´Öê®™ËüÃÖ (c) ™üÖÃÛú²ÖÖ¸ü  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

73. ‹Ûú †Öê¯Ö®Ö ×¾Ö®›üÖê ÃÖê ¤æüÃÖ¸üß ×¾Ö®›üÖê ´Öë •ÖÖ®Öê Ûúß ¯ÖÏ×ÛÎúµÖÖ •ÖÖ®Öß •ÖÖŸÖß Æîü  
 (a) ™üÖÃÛú ×Ã¾ÖØ“ÖÝÖ  (b) ×ÃÖÃ™ü´Ö ÛúÖ»Ö  (c) ´ÖæØ¾ÖÝÖ  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

74. ÛúÖî®Ö ÃÖÖ ¯ÖÏ“ÖÖ»Ö®Ö ŸÖÓ¡Ö ÛúÖ ÛúÖµÖÔ ®ÖÆüà Æîü ? 
 (a) ¯ÖÏ»ÖêÜÖ ÃÖÓ¯ÖÖ¤ü®Ö  (b) Ã´Öé×ŸÖ ¯ÖÏ²Ö®¬Ö®Ö  
 (c) ÃÖÓÃÖÖ×¬Ö¡Ö ×®ÖµÖŸÖ®Ö  (d) ÛÎú´ÖÖ¤êü¿Ö ³ÖÖ¸üÞÖ  
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75. Which is not a system software ? 
 (a) DOS (b) Unix (c) Windows (d) MS-Office 
 

76. Which of the following is not a GUI component ? 
 (a) Radio button (b) Menu (c) Command (d) Text Box 
 

77. A program in execution is called  
 (a) Process (b) Instruction (c) Procedure (d) Function 
 

78. The main reason to encrypt a file is to  
 (a) Reduce its size (b) Secure it for transmission 
 (c) Prepare it for backup (d) None of the above 
 

79. Date and time are available on the desktop at  
 (a) My Computer (b) Recycle Bin 
 (c) Task bar (d) None of the above  
 

80. A folder can contain 
 (a) Files only (b) Files and Folders (c) Folders only (d) None of these 
 

81. When a computer systems hardware communicates with input or output hardware, the 
operating system works through 

 (a) Device Driver (b) Network (c) Processor (d) None of these 
 

82. A network printer is a printer over a network shared by 
 (a) only two people (b) two server 
 (c) several people (d) None of the above 
 

83. For accessing the networks we use the icon 
 (a) Network Neighbourhood (b) Recycle bin 
 (c) My Documents (d) None of the above 
 

84. A DBMS file is a collection of  
 (a) Logically related multiple records (b) Multiple related fields 
 (c) Multiple related keys (d) None of these 
 

85. Following are the file compression programs, except  
 (a) WinRAR (b) PKZIP (c) RAID (d) WinZIP 
 

86. A software is also called as a  
 (a) Procedure (b) Data (c) Program (d) Information 
 

87. Which of the following attribute prevents changes to files and folders ?  
 (a) Read only (b) Hidden (c) Archive (d) System 
 

88. _________ is a windows utility for optimizing disk space. 
 (a) Backup (b) Disk fragmentation 
 (c) Disk format (d) Restore 
 

89. Additional information about a program is displayed through ________ box. 
 (a) minimize (b) maximize (c) dialog (d) None of these 
 

90. Windows is based on 
 (a) Multitasking (b) Parallel Processing 
 (c) Real Time (d) Batch Processing 
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75. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ×ÃÖÃ™ü´Ö ÃÖÖò°™ü¾ÖêµÖ¸ü ®ÖÆüà Æîü ? 
 (a) ›üÖòÃÖ  (b) µÖæ×®ÖŒÃÖ  (c) ×¾Ö®›üÖê•Ö  (d) ‹´Ö.‹ÃÖ.-†Öò×±úÃÖ  
 

76. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ‹Ûú •Öß.µÖæ.†Ö‡Ô. (GUI) †¾ÖµÖ¾Ö ®ÖÆüà Æîü ? 
 (a) ¸êü×›üµÖÖê ²Ö™ü®Ö  (b) ´Öê®µÖæ  (c) Ûú´ÖÖÞ›ü  (d) ™êüŒÃ™ü ²ÖÖòŒÃÖ  
 

77. ÛÎú´ÖÖ¤êü¿Ö Ûúß ×®ÖÂ¯ÖÖ¤ü®Ö †¾ÖÃ£ÖÖ ÛúÆü»ÖÖŸÖß Æîü 
 (a) ¯ÖÏÛÎú´Ö  (b) †®Öã¤êü¿Ö  (c) ¯ÖÏ×ÛÎúµÖÖ  (d) ¯ÖÏÛúÖµÖÔ  
 

78. ‹Ûú ÃÖÓ×“ÖÛúÖ Ûêú Ûæú™ü»ÖêÜÖ Ûú¸ü®Öê ÛúÖ ´ÖãÜµÖ ÛúÖ¸üÞÖ ÆüÖêŸÖÖ Æîü  
 (a) ˆÃÖÛêú †ÖÛúÖ¸ü ÛúÖê Ûú´Ö Ûú¸ü®ÖÖ …   (b) ÃÖÓ“Ö¸üÞÖ ÆêüŸÖã ÃÖã¸ü×õÖŸÖ Ûú¸ü®ÖÖ …  
 (c) ¯ÖæÙŸÖÛú¸ü ÆêüŸÖã ×®ÖÙ´ÖŸÖ Ûú¸ü®ÖÖ …  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

79. ›êüÃÛú™üÖò¯Ö ¯Ö¸ü ×¤ü®ÖÖÓÛú ¾Ö ÃÖ´ÖµÖ ×®Ö´®Ö ¯Ö¸ü ˆ¯Ö»Ö²¬Ö ÆüÖêŸÖÖ Æîü : 
 (a) ´ÖÖ‡Ô Ûú´¯µÖæ™ü¸ü  (b) ×¸üÃÖÖ‡×Ûú»Ö ×²Ö®Ö  
 (c) ™üÖÃÛú²ÖÖ¸ü  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

80. ‹Ûú ±úÖê»›ü¸ü ¸üÜÖ ÃÖÛúŸÖÖ Æîü  
 (a) Ûêú¾Ö»Ö ±úÖ‡»ÃÖ  (b) ±úÖ‡»ÃÖ ¾Ö ±úÖê»›üÃÖÔ  (c) Ûêú¾Ö»Ö ±úÖê»›üÃÖÔ  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

81. •Ö²Ö ‹Ûú Ûú´¯µÖæ™ü¸ü ×ÃÖÃ™ü´Ö ÛúÖ ÆüÖ›Ôü¾ÖêµÖ¸ü ‡®Ö¯Öã™ü µÖÖ †Öˆ™ü¯Öã™ü ÆüÖ›Ôü¾ÖêµÖ¸ü ÃÖê ÃÖ´¯ÖÛÔú Ûú¸üŸÖÖ Æîü, †Öò¯Ö¸êüØ™üÝÖ ×ÃÖÃ™ü´Ö ×®Ö´®Ö Ûêú 
«üÖ¸üÖ ÛúÖµÖÔ Ûú¸üŸÖÖ Æîü : 

 (a) ×›ü¾ÖÖ‡ÃÖ ›ÒüÖ‡¾Ö¸ü  (b) ®Öê™ü¾ÖÛÔú  (c) ¯ÖÏÖêÃÖêÃÖ¸ü  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

82. ‹Ûú ®Öê™ü¾ÖÛÔú ×¯ÖÏ®™ü¸ü ¾ÖÆü ×¯ÖÏ®™ü¸ü Æîü, ×•ÖÃÖê ®Öê™ü¾ÖÛÔú ¯Ö¸ü ÃÖÖ—ÖÖ ×ÛúµÖÖ •ÖÖŸÖÖ Æîü …  
 (a) Ûêú¾Ö»Ö ¤üÖê ¾µÖ×ŒŸÖµÖÖë «üÖ¸üÖ   (b) ¤üÖê ÃÖ¾ÖÔ¸ü «üÖ¸üÖ  
 (c) †×¬ÖÛú ¾µÖ×ŒŸÖµÖÖë «üÖ¸üÖ   (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

83. ®Öê™ü¾ÖÛÔú ÛúÖê ‹êŒÃÖêÃÖ Ûú¸ü®Öê ÆêüŸÖã ×®Ö´®Ö ´Öë ÃÖê ×ÛúÃÖ †Ö‡Ûú®Ö ÛúÖ ¯ÖÏµÖÖêÝÖ Ûú¸üŸÖê Æïü ? 
 (a) ®Öê™ü¾ÖÛÔú ®Öê²Ö¸üÆãü›ü  (b) ×¸üÃÖÖ‡×Ûú»Ö ×²Ö®Ö  
 (c) ´ÖÖ‡Ô ›üÖòŒµÖæ´Öë™ËüÃÖ  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

84. DBMS ±úÖ‡»Ö ________ ÛúÖ ÃÖÓÛú»Ö®Ö Æîü … 
 (a) »ÖÖò×•ÖÛú»Öß ×¸ü»Öê™êü›ü ´Ö»™üß¯Ö»Ö ×¸üÛúÖò›ÔËüÃÖ  (b) ´Ö»™üß¯Ö»Ö ×¸ü»Öê™êü›ü ×±ú»›ËüÃÖ  
 (c) ´Ö»™üß¯Ö»Ö ×¸ü»Öê™êü›ü Ûúß•Ö (keys)  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

85. ×®Ö´®Ö×»Ö×ÜÖŸÖ ÃÖ³Öß ±úÖ‡»Ö Ûú´¯ÖÏê¿Ö®Ö ¯ÖÏÖêÝÖÏÖ´Ö Æîü, ×ÃÖ¾ÖÖµÖ –  
 (a) WinRAR  (b) PKZIP  (c) RAID  (d) WinZIP  
 

86. ÃÖÖò°™ü¾ÖêµÖ¸ü ÛúÖê _______ ³Öß ÛúÆüŸÖê Æïü …  
 (a) ¯ÖÏÖêÃÖß•Ö¸ü  (b) ›üÖ™üÖ  (c) ¯ÖÏÖêÝÖÏÖ´Ö  (d) ‡®±úÖò´Öì¿Ö®Ö  
 

87. ×®Ö´®Ö×»Ö×ÜÖŸÖ ´Öë ÃÖê ÛúÖî®Ö ÃÖÖ ÝÖãÞÖ •ÖÖê ±úÖ‡»ÃÖ ŸÖ£ÖÖ ±úÖê»›üÃÖÔ ´Öë ¯Ö×¸ü¾ÖŸÖÔ®Ö ÃÖê ¸üÖêÛúŸÖÖ Æîü ? 
 (a) ¸üß›ü †Öê®Ö»Öß  (b) ×Æü›êü®Ö  (c) †ÖÙ“Ö¾Ö  (d) ×ÃÖÃ™ü´Ö  
 

88. _______ ‹Ûú ×¾Ö®›üÖê•Ö µÖæ×™ü×»Ö™üß Æîü •ÖÖê ×›üÃÛú Ã¯ÖêÃÖ ÛúÖê †Öò¯™üß´ÖÖ‡•Ö Ûú¸üŸÖß Æîü … 
 (a) ²ÖîÛú†¯Ö  (b) ×›üÃÛú ±ÏîúÝÖ´Öê®™êü¿Ö®Ö  
 (c) ×›üÃÛú ±úÖò¸ü´Öê™ü  (d) ×¸üÃ™üÖê¸ü  
 

89. ‹Ûú ¯ÖÏÖêÝÖÏÖ´Ö Ûêú ²ÖÖ¸êü ´Öë †×ŸÖ×¸üŒŸÖ ÃÖæ“Ö®ÖÖ _____ ²ÖÖòŒÃÖ «üÖ¸üÖ ¯ÖÏ¤üÙ¿ÖŸÖ ÆüÖêŸÖß Æîü … 
 (a) ×´Ö®Öß´ÖÖ‡•Ö  (b) ´ÖîŒ•Öß´ÖÖ‡•Ö (c) ›üÖµÖ»ÖÖòÝÖ  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà  
 

90. ×¾Ö®›üÖê•Ö ×®Ö´®Ö ¯Ö¸ü †Ö¬ÖÖ×¸üŸÖ Æîü : 
 (a) ´Ö»™üß ™üÖØÃÛúÝÖ  (b) ¯Öî¸êü»Ö»Ö ¯ÖÏÖêÃÖêØÃÖÝÖ  (c) ×¸üµÖ»Ö ™üÖ‡´Ö  (d) ²Öî“Ö ¯ÖÏÖêÃÖêØÃÖÝÖ  
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91. Spelling and grammar can be detected by pressing key  
 (a) Shift + F7 (b) Ctrl + F7 (c) F7 (d) Alt + F7 
 
92. Which key underline the selected text ? 
 (a) Ctrl + W (b) Ctrl + C (c) Ctrl + Z (d) Ctrl + U 
 
93. Which of the following line spacing is invalid in MS-Word ? 
 (a) Single (b) Triple (c) Multiple (d) Double  
 
94. What is the shortcut key you can press to create a copyright symbol in MS-Word ? 
 (a) Alt + C (b) Ctrl + C 
 (c) Ctrl + Shift + C (d) Alt + Ctrl + C  
 
95. Bullets and numbering is in  
 (a) Insert Tab (b) View Tab (c) Home Tab (d) Page Layout Tab 
 
96. You can use ________ to copy selected text and _________ to paste it in a document. 
 (a) Ctrl + C, Ctrl + V (b) Ctrl + C, Ctrl + P 
 (c) Ctrl + S, Ctrl + S (d) Shift + C, Alt + P 
 
97. MS-Office was developed by 
 (a) Novel (b) Coral (c) Lotus (d) Microsoft 
 
98. The name a user assigns to a document is called a  
 (a) File name (b) Program (c) Record (d) Data 
 
99. By default, your documents are printed in which orientation ? 
 (a) Landscape  (b) Portrait 
 (c) Rotate by 180 degree (d) None of these 
 
100. What menu is selected to change Font and Style ? 
 (a) File (b) Tools (c) Edit (d) Format 
 
101. For creating a document, you use ________ command at file menu. 
 (a) Open (b) Close (c) New (d) Save 
 

102. What menu is selected to save or save as ? 
 (a) File (b) Format (c) Tools (d) Edit 
 

103. Where does a header appear in a document ? 
 (a) At the top of every page (b) At the bottom of every page 
 (c) Only on the first page (d) Only on the last page 
 

104. Which menu is selected to cut, copy and paste ? 
 (a) File (b) Tools (c) Table (d) Edit 
 

105. Which is the standard file format for text files ? 
 (a) .jpg (b) .bmp (c) .txt (d) .xls 
 

106. An arrangement of information in row and column is called as 
 (a) Column (b) Table (c) Case (d) Row 
 

107. How many types of alignment available in MS-Word ? 
 (a) 1 (b) 2 (c) 3 (d) 4 
 

108. Ctrl + Z is used 
 (a) To Undo (b) To Delete (c) To Copy  (d) None of these 
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91. ¾ÖÞÖÔ ×¾Ö®µÖÖÃÖ ¾Ö ¾µÖÖÛú¸üÞÖ ×ÛúÃÖ ÛãÓú•Öß ÃÖê ¯ÖŸÖÖ »ÖÝÖÖµÖÖ •ÖÖŸÖÖ Æîü ? 
 (a) Shift + F7  (b) Ctrl + F7  (c) F7  (d) Alt + F7  
 

92. “Öã®Öê Æãü‹ ™êüŒÃ™ü ÛúÖê ¸êüÜÖÖÓ×ÛúŸÖ (underline) Ûú¸ü®Öê Ûêú ×»Ö‹ ×ÛúÃÖ ÛãÓú•Öß ÛúÖ ¯ÖÏµÖÖêÝÖ Ûú¸üŸÖê Æïü ? 
 (a) Ctrl + W  (b) Ctrl + C  (c) Ctrl + Z  (d) Ctrl + U  
 

93. MS-Word ´Öë ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ÃÖß »ÖÖ‡®Ö Ã¯ÖêØÃÖÝÖ †´ÖÖ®µÖ Æîü ? 
 (a) ØÃÖÝÖ»Ö  (b) ×™Òü¯Ö»Ö  (c) ´Ö»™üß¯Ö»Ö  (d) ›ü²Ö»Ö  
 

94. MS-Word ´Öë ÛúÖò¯Öß ¸üÖ‡™ü ×ÃÖ´²Ö»Ö ÛúÖê ²Ö®ÖÖ®Öê Ûêú ×»Ö‹ ÛúÖî®Ö ÃÖß ¿ÖÖò™ÔüÛú™ü Ûúß (key) †Ö¯Ö ¤ü²ÖÖ ÃÖÛúŸÖê Æïü ? 
 (a) Alt + C  (b) Ctrl + C  (c) Ctrl + Shift + C  (d) Alt + Ctrl + C  
 

95. ²Öã»Öê™ü †Öî¸ü ®Ö´²ÖØ¸üÝÖ _______ ´Öë Æîü … 
 (a) ‡®ÃÖ™Ôü ™îü²Ö  (b) ¾µÖæ ™îü²Ö  (c) ÆüÖê´Ö ™îü²Ö  (d) ¯Öê•Ö »Öê†Öˆ™ü ™îü²Ö  
 

96. _________ ÛúÖ ¯ÖÏµÖÖêÝÖ “ÖµÖ×®ÖŸÖ ™êüŒÃ™ü ÛúÖê ÛúÖò¯Öß Ûú¸ü®Öê †Öî¸ü ________ ¤üÃŸÖÖ¾Öê•Ö ´Öë ¯ÖêÃ™ü Ûú¸ü®Öê ÆêüŸÖã ÆüÖêŸÖÖ Æîü …  
 (a) Ctrl + C, Ctrl + V  (b) Ctrl + C, Ctrl + P  
 (c) Ctrl + S, Ctrl + S  (d) Shift + C, Alt + P 
 

97. ‹´Ö.‹ÃÖ.-†Öò×±úÃÖ ×®Ö´®Ö «üÖ¸üÖ ×¾ÖÛú×ÃÖŸÖ ×ÛúµÖÖ ÝÖµÖÖ £ÖÖ : 
 (a) ®ÖÖò¾Öêê»Ö  (b) ÛúÖê¸ü»Ö  (c) »ÖÖê™üÃÖ  (d) ´ÖÖ‡ÛÎúÖêÃÖÖò°™ü  
 

98. ¯ÖÏµÖÖêŒŸÖÖ, ¤üÃŸÖÖ¾Öê•Ö ÛúÖê •ÖÖê ®ÖÖ´Ö ¤êüŸÖÖ Æîü ˆÃÖê _______ ÛúÆüŸÖê Æïü …  
 (a) ±úÖ‡»Ö ®Öê´Ö  (b) ¯ÖÏÖêÝÖÏÖ´Ö  (c) ×¸üÛúÖò›Ôü  (d) ›üÖ™üÖ  
 

99. ×›ü±úÖ»™ü ºþ¯Ö ´Öë †Ö¯ÖÛúÖ ›üÖòŒµÖæ´Öë™ü ×ÛúÃÖ †Öê×¸üµÖê®™êü¿Ö®Ö ´Öë ×¯ÖÏ®™ü ÆüÖêŸÖÖ Æîü ? 
 (a) »Öï›üÃÛêú¯Ö  (b) ¯ÖÖê™Òìü™ü  (c) 180 ×›üÝÖÏß ‘Öã´ÖÖ¾Ö  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

100. ±úÖ®™ü †Öî¸ü Ã™üÖ‡»Ö ÛúÖê ²Ö¤ü»Ö®Öê Ûêú ×»Ö‹ ×ÛúÃÖ ´Öê®µÖæ ÛúÖ “Öã®ÖÖ¾Ö ×ÛúµÖÖ •ÖÖŸÖÖ Æîü ? 
 (a) ±úÖ‡»Ö  (b) ™æü»ÃÖ  (c) ‹×›ü™ü  (d) ±úÖò¸ü´Öê™ü  
 

101. ›üÖòŒµÖæ´Öë™ü ×®Ö´ÖÖÔÞÖ Ûú¸ü®Öê Ûêú ×»Ö‹ †Ö¯Ö ±úÖ‡»Ö ´Öê®µÖæ ¯Ö¸ü _______ Ûú´ÖÖÞ›ü ÛúÖ ¯ÖÏµÖÖêÝÖ Ûú¸üŸÖê Æïü … 
 (a) †Öê¯Ö®Ö (Open) (b) Œ»ÖÖê•Ö (Close) (c) ®µÖæ (New) (d) ÃÖê¾Ö (Save) 
 

102. ÃÖê¾Ö (Save) †£Ö¾ÖÖ ÃÖê¾Ö ‹ê•Ö (Save as) Ûêú ×»Ö‹ ÛúÖî®Ö ÃÖÖ ´Öê®µÖæ “Öã®ÖÖ •ÖÖŸÖÖ Æîü ? 
 (a) ±úÖ‡»Ö  (b) ±úÖò¸ü´Öê™ü  (c) ™æü»ÃÖ  (d) ‹×›ü™ü  
 

103. ×ÛúÃÖß ›üÖòŒµÖæ´Öë™ü ´Öë Æêü›ü¸ü (Header) ÛúÆüÖÑ ÆüÖêŸÖÖ Æîü ? 
 (a) ¯ÖÏŸµÖêÛú ¯Öê•Ö Ûêú ¿ÖßÂÖÔ ¯Ö¸ü  (b) ¯ÖÏŸµÖêÛú ¯Öê•Ö Ûêú †Ö¬ÖÖ¸ü (×®Ö“Ö»Öê ³ÖÖÝÖ) ¯Ö¸ü   
 (c) Ûêú¾Ö»Ö ¯ÖÏ£Ö´Ö ¯Öê•Ö ¯Ö¸ü   (d) Ûêú¾Ö»Ö †×®ŸÖ´Ö ¯Öê•Ö ¯Ö¸ü   
 

104. Ûú™ü (cut), ÛúÖò¯Öß (copy) †Öî¸ü ¯ÖêÃ™ü (paste) ×ÛúÃÖ ´Öê®µÖæ ÃÖê “Öã®Öê •ÖÖŸÖê Æïü ? 
 (a) ±úÖ‡»Ö  (b) ™æü»ÃÖ  (c) ™êü²Ö»Ö  (d) ‹×›ü™ü  
 

105. ™êüŒÃ™ü ±úÖ‡»ÃÖ Ûêú ×»Ö‹ Ã™îüÞ›ü›Ôü ±úÖ‡»Ö ±úÖ¸ü´Öê™ü ŒµÖÖ ÆüÖêŸÖÖ Æîü ? 
 (a) .jpg  (b) .bmp  (c) .txt  (d) .xls  
 

106. ÃÖæ“Ö®ÖÖ†Öë ÛúÖê ¯ÖÓ×ŒŸÖ ¾Ö ÃŸÖ´³Ö Ûêú ºþ¯Ö ´Öë ¾µÖ¾Ö×Ã£ÖŸÖ Ûú¸ü®Öê ÛúÖê _______ ÛúÆüÖ •ÖÖŸÖÖ Æîü … 
 (a) ÛúÖò»Ö´Ö  (b) ™êü²Ö»Ö  (c) ÛêúÃÖ (case)  (d) ¸üÖê (row)  
 

107. ‹´Ö.‹ÃÖ.-¾Ö›Ôü ´Öë ×ÛúŸÖ®Öê ¯ÖÏÛúÖ¸ü Ûêú ‹»ÖÖ‡®Ö´Öë™ü ˆ¯Ö»Ö²¬Ö Æïü ? 
 (a) 1  (b) 2  (c) 3  (d) 4  
 

108. Ctrl +Z  ¯ÖÏµÖãŒŸÖ ÆüÖêŸÖÖ Æîü  
 (a) undo Ûú¸ü®Öê Ûêú ×»Ö‹  (b) Æü™üÖ®Öê Ûêú ×»Ö‹  
 (c) ÛúÖò¯Öß Ûú¸ü®Öê Ûêú ×»Ö‹   (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
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109. The ________ is a dictionary of synonyms which you can use to find words that are 
synonymous with a term. 

 (a) Spelling (b) Research  (c) Translate (d) Thesaurus 
 

110. To create a form letter which you intend to print or e-mail multiple times, sending each 
copy to different recipient is called  

 (a) Create label (b) Mail merge 
 (c) Cross reference (d) None of the above 
 

111. ________ is a technique used to take out unwanted background areas. 
 (a) Framing (b) Clipping (c) Cropping (d) None of these 
 

112. The blinking point which shows your position in the text is called  
 (a) Blinker (b) Cursor (c) Causer (d) Pointer 
 

113. To save an existing file with new name at new location we should use _________ 
command. 

 (a) Save (b) Edit 
 (c) Save and Replace (d) None of the above 
 

114. What menu is selected to print ? 
 (a) Tools (b) View (c) File (d) Edit 
 

115. Which of the following is graphics solution for word processor ? 
 (a) Clip art (b) Word pad (c) Drop cap (d) All of these 
 

116. Any data that is typed in a worksheet appears  
 (a) in both the active cell and the formula bar. 
 (b) in the active cell only. 
 (c) in the formula bar first and when you press Enter key into the active cell. 
 (d) None of the above 
 

117. The cell reference for a range of cells that starts in cell B1 and goes over to column G and 
down to row 10 is  

 (a) G1 – G10 (b) B1. G10 (c) B1 : G10 (d) B1 .. G10 
 

118. What is entered by the function = today ( ) ? 
 (a) The date value for the day according to system clock. 
 (b) The time value according to system clock. 
 (c) Today date as text format 
 (d) None of the above 
 

119. Which one of the following is a pre-recorded formula for calculation as a shortcut in Excel ? 
 (a) Value (b) Data Series (c) Field (d) Function  
 

120. In MS-Excel every cell is referred by cell address which is  
 (a) Cell column label 
 (b) Cell column label and worksheet tab name 
 (c) Cell row label 
 (d) Cell column and row label 
 

121. When you move your mouse over a sizing handle the pointer becomes a  
 (a) Round arrow (b) Two headed arrow 
 (c) Plus sign (d) Four headed arrow 
 

122. Which of the following is an absolute cell address ? 
 (a) A1 (b) #a≠1 (c) $A$1 (d) !A!1 
 

123. Workbook is a collection of ________ in MS-Excel. 
 (a) Books (b) Workbooks (c) Tabs (d) Sheets 
 

124. A __________ is a visual representation of data in MS-Excel. 
 (a) Chart (b) Picture (c) Graphic (d) Table 
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109. ________ ÃÖ´ÖÖ®ÖÖ£ÖÔÛú ¿Ö²¤üÖë ÛúÖ ¿Ö²¤üÛúÖê¿Ö Æîü ×•ÖÃÖÛúÖ ˆ¯ÖµÖÖêÝÖ ÃÖ´ÖÖ®ÖÖ£ÖÔÛú ¿Ö²¤üÖë ÛúÖê ÜÖÖê•Ö®Öê Ûêú ×»Ö‹ Ûú¸ü ÃÖÛúŸÖê Æïü …  
 (a) Ã¯ÖêØ»ÖÝÖ  (b) ×¸üÃÖ“ÖÔ  (c) ™ÒüÖÓÃÖ»Öê™ü  (d) ×£ÖÃÖÖê¸üÃÖ  
 

110. ×®Ö´®Ö ´Öë ÃÖê ×ÛúÃÖÛêú «üÖ¸üÖ Æü´Ö ‹Ûú ‹êÃÖÖ ±úÖò´ÖÔ ¯Ö¡Ö ŸÖîµÖÖ¸ü Ûú¸üŸÖê Æïü ×•ÖÃÖê ‹Ûú ÃÖê †×¬ÖÛú ²ÖÖ¸ü ”û¯ÖÖµÖÖ µÖÖ ‡Ô-´Öê»Ö ×ÛúµÖÖ •ÖÖ 
ÃÖÛúŸÖÖ Æîü ŸÖ£ÖÖ ‡ÃÖÛúß ¯ÖÏ×ŸÖ ×¾Ö×³Ö®®Ö »ÖÖêÝÖÖë ÛúÖê ³Öê•Öß •ÖÖ ÃÖÛúŸÖß Æîü ? 

 (a) ×ÛÎú‹™ü »Öê²Ö»Ö  (b) ´Öê»Ö ´Ö•ÖÔ  
 (c) ÛÎúÖòÃÖ ×¸ü±ú¸êü®ÃÖ  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

111. _______ †¾ÖÖÓ×”ûŸÖ ¯ÖéÂšü³Öæ×´Ö õÖê¡Ö ÛúÖê Æü™üÖ®Öê Ûúß ŸÖÛú®ÖßÛú Æîü … 
 (a) ±ÏêúØ´ÖÝÖ  (b) ×Œ»ÖØ¯ÖÝÖ  (c) ÛÎúÖòØ¯ÖÝÖ  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

112. ™êüŒÃ™ü ´Öë ¾ÖÆü Ø²»ÖØÛúÝÖ ¯¾ÖÖ‡Ó™ü •ÖÖê †Ö¯ÖÛúß ¯ÖÖê×•Ö¿Ö®Ö ÛúÖê ¯ÖÏ¤üÙ¿ÖŸÖ Ûú¸üŸÖÖ Æîü, ÛúÆü»ÖÖŸÖÖ Æîü  
 (a) Ø²»ÖÛú¸ü  (b) ÛúÃÖÔ¸ü  (c) ÛúÖòÃÖ¸ü  (d) ¯¾ÖÖò‡Ó™ü¸ü  
 

113. ®ÖµÖê ®ÖÖ´Ö ÃÖê ®ÖµÖê »ÖÖêÛêú¿Ö®Ö ¯Ö¸ü ×ÛúÃÖß ×¾Öª´ÖÖ®Ö ±úÖ‡»Ö ÛúÖê ÃÖÓ×“ÖŸÖ Ûú¸ü®Öê ÆêüŸÖã †Ö¯ÖÛúÖê _______ Ûú´ÖÖÓ›ü ÛúÖ ¯ÖÏµÖÖêÝÖ Ûú¸ü®ÖÖ 
“ÖÖ×Æü‹ …  

 (a) ÃÖê¾Ö (Save)   (b) ‹×›ü™ü (Edit) 
 (c) ÃÖê¾Ö (Save) ‹Þ›ü ¸üß¯»ÖêÃÖü (Replace)  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

114. ×¯ÖÏ®™ü Ûú¸ü®Öê Ûêú ×»Ö‹ ÛúÖî®Ö ÃÖÖ ´Öê®µÖæ “ÖµÖ®Ö Ûú¸üŸÖê Æïü ? 
 (a) ™æü»ÃÖ  (b) ¾µÖæ  (c) ±úÖ‡»Ö  (d) ‹×›ü™ü  
 

115. ×®Ö´®Ö×»Ö×ÜÖŸÖ ´Öë ¾Ö›Ôü ¯ÖÏÖêÃÖêÃÖ¸ü Ûêú ×»Ö‹ ÛúÖî®Ö ÝÖÏÖ×±úÛú Æü»Ö Æîü ? 
 (a) ×Œ»Ö¯Ö †Ö™Ôü  (b) ¾Ö›Ôü ¯Öî›ü  (c) ›ÒüÖò¯Ö Ûîú¯Ö  (d) µÖê ÃÖ³Öß   
 

116. ÛúÖê‡Ô ›üÖ™üÖ •ÖÖê ×Ûú ¾ÖÛÔú¿Öß™ü ´Öë ×»ÖÜÖÖ •ÖÖŸÖÖ Æîü, ¾ÖÖê ×¤üÜÖÖµÖß ¤êüŸÖÖ Æîü  
 (a) ‹Œ™üß¾Ö ÃÖê»Ö ŸÖ£ÖÖ ±úÖò´ÖæÔ»ÖÖ ²ÖÖ¸ü ¤üÖê®ÖÖë ´Öë  
  (b) Ûêú¾Ö»Ö ‹Œ™üß¾Ö ÃÖê»Ö ´Öë  
 (c) ÃÖ¾ÖÔ¯ÖÏ£Ö´Ö ±úÖò´ÖæÔ»ÖÖ²ÖÖ¸ü ´Öë ŸÖ£ÖÖ Enter Key ¤ü²ÖÖ®Öê ¯Ö¸ü ‹×Œ™ü¾Ö ÃÖê»Ö ´Öë  
  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

117. ÃÖê»Ö B1 ÃÖê ¯ÖÏÖ¸ü´³Ö ÆüÖêÛú¸ü ÛúÖò»Ö´Ö G †Öî¸ü ®Öß“Öê Row10 Ûêú ×»Ö‹ ÃÖê»Ö ×¸ü±ú¸ëüÃÖ Æîü  
 (a) G1– G10  (b) B1.G10  (c) B1: G10  (d) B1.. G10  
 

118. ±úòŒ¿Ö®Ö = ™ãü›êü( ) Ûêú «üÖ¸üÖ ŒµÖÖ ¯ÖÏ×¾ÖÂ™ü ÆüÖêŸÖÖ Æîü ? 
 (a) ×ÃÖÃ™ü´Ö ‘Ö›Ìüß Ûêú †®ÖãÃÖÖ¸ü ×¤ü®Ö Ûúß ×¤ü®ÖÖÓÛú  (b) ×ÃÖÃ™ü´Ö ‘Ö›Ìüß Ûêú †®ÖãÃÖÖ¸ü ÃÖ´ÖµÖ   
 (c) ™êüŒÃ™ü ±úÖò´Öì™ü ´Öë †Ö•Ö Ûúß ×¤ü®ÖÖÓÛú   (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

119. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ‹ŒÃÖê»Ö ´Öë ¿ÖÖò™ÔüÛú™ü •ÖîÃÖê Æîü •ÖÖê ÝÖÞÖ®ÖÖ†Öë Ûêú ×»Ö‹ ¯ÖÏß-×¸üÛúÖò›ìü›ü ±úÖò´ÖæÔ»ÖÖ Æîü ? 
 (a) ¾Öî»µÖæ  (b) ›üÖ™üÖ ÃÖß¸üß•Ö  (c) ×±ú»›ü  (d) ±úòŒ¿Ö®Ö  
 

120. ‹´Ö.‹ÃÖ.-‹ŒÃÖê»Ö ´Öë ¯ÖÏŸµÖêÛú ÃÖê»Ö †¯Ö®Öê ÃÖê»Ö ‹›ÒêüÃÖ ÃÖê ÃÖÓ¤üÙ³ÖŸÖ ×ÛúµÖÖ •ÖÖŸÖÖ Æîü, •ÖÖê ______ Æîü … 
 (a) ÃÖê»Ö ÛúÖò»Ö´Ö »Öê²Ö»Ö  (b) ÃÖê»Ö ÛúÖò»Ö´Ö »Öê²Ö»Ö †Öî¸ü ¾ÖÛÔú¿Öß™ü ™îü²Ö ®Öê´Ö  
 (c) ÃÖê»Ö ¸üÖê »Öê²Ö»Ö  (d) ÃÖê»Ö ÛúÖò»Ö´Ö †Öî¸ü ¸üÖê »Öê²Ö»Ö  
 

121. •Ö²Ö †Ö¯Ö †¯Ö®Öê ´ÖÖˆÃÖ ÛúÖê ÃÖÖ‡Ø•ÖÝÖ Æïü›ü»Ö Ûêú ‰ú¯Ö¸ü move Ûú¸üÖŸÖê Æïü, ŸÖÖê ¯¾ÖÖò‡Ó™ü¸ü ______ Ûúß ŸÖ¸üÆü ÆüÖêŸÖÖ Æîü …  
 (a) ¸üÖˆÞ›ü ‹ê¸üÖê  (b) ¤üÖê ×ÃÖ¸üÖë ¾ÖÖ»ÖÖ ‹ê¸üÖê  (c) ¯»ÖÃÖ ×“ÖÅ®Ö  (d) “ÖÖ¸ü ×ÃÖ¸üÖë ¾ÖÖ»ÖÖ ‹ê¸üÖê  
 

122. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ×®Ö¸ü¯ÖêõÖ ÃÖê»Ö ÃÖ®¤ü³ÖÔ Æîü ? 
 (a) A1  (b) #a#1  (c) $A$1  (d) !A!1  
 

123. ‹´Ö.‹ÃÖ.-‹ŒÃÖê»Ö ´Öë ¾ÖÛÔú²ÖãÛú _______ ÛúÖ ÃÖÓÛú»Ö®Ö Æîü … 
 (a) ²ÖãŒÃÖ  (b) ¾ÖÛÔú²ÖãŒÃÖ  (c) ™îü²ÃÖ  (d) ¿Öß™ËüÃÖ  
 

124. ‹´Ö.‹ÃÖ.-‹ŒÃÖê»Ö ´Öë, _______ ›üÖ™üÖ ÛúÖ ¥ü×Â™üÝÖŸÖ ¯ÖÏÃŸÖãŸÖßÛú¸üÞÖ Æîü … 
 (a) “ÖÖ™Ôü  (b) ×¯ÖŒ“Ö¸ü  (c) ÝÖÏÖ×±úŒÃÖ  (d) ™êü²Ö»Ö  
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125. In MS-Excel _________ is a method / tool which aids you in forecasting values. 
 (a) Find (b) Replace (c) Goal seek (d) Go To 
 

126. Which of the following functions of MS-Excel 2007 display the sum of the selected cells 
just after the selected cells ? 

 (a) SUM (b) TOTAL (c) ADD (d) None of these 
 

127. Which of the following command of Excel convert a column of data into row ?  
 (a) Cut and Paste (b) Paste special → Transpose 
 (c) Orientation (d) None of the above 
 

128. Which of the following function in Excel 2007 count the number of characters in a cell ? 
 (a) Length (b) LGT (c) LT (d) LEN 
 

129. The command Home → Edit → Fill Across worksheet of Excel 2007 is active only 
when  

 (a) one sheet is selected. (b) when many sheets are selected. 
 (c) when no sheet is selected. (d) None of the above 
 

130. In MS-Excel list of only those entries which meet certain criteria, can be obtained by 
using menu 

 (a) Data → Sort  (b) Data → Filter  
 (c) Format → Sheet (d) None of the above 
 

131. How do you save a presentation under a new file name ? 
 (a) Select the file menu and choose save as  
 (b) When you choose PowerPoint the file will automatically be saved 
 (c) Select the file menu and choose save 
 (d) None of the above 
 

132. A character that is raised and smaller in size and placed above the baseline is known as  
 (a) Outlined (b) Raised (c) Superscript (d) Subscript 
 

133. Which of the following is a presentation graphics software ? 
 (a) MS-Windows (b) MS-PowerPoint (c) MS-Excel (d) MS-Word 
 

134. Which command brings you to the first slide in your presentation ? 
 (a) Page Up (b) Shift + Home (c) Alt + Home (d) Ctrl + Home 
 

135. PowerPoint lets you add new slide to your presentation using  
 (a) Insert → Slide (b) Insert → New Slide 
 (c) Format → New Slide (d) None of the above 
 

136. To decrease the font size, the shortcut used is _______ in presentation. 
 (a) Ctrl + Shift + > (b) Ctrl + Shift + < 
 (c) Ctrl + > (d) Ctrl + < 
 

137. To personalize your AutoCorrect, use  
 (a) Tools → AutoCorrect  (b) Insert → AutoCorrect  
 (c) Format → AutoCorrect (d) None of the above 
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125. ‹´Ö.‹ÃÖ.-‹ŒÃÖê»Ö ´Öë, _______ ‹êÃÖß ¯Ö¨ü×ŸÖ/™æü»Ö Æîü •ÖÖê ¾Öî»µÖæ•Ö Ûêú ¯Öæ¾ÖÖÔ®Öã´ÖÖ®Ö ´Öë ´Ö¤ü¤ü Ûú¸üŸÖÖ Æîü … 
 (a) ±úÖ‡Ó›ü  (b) ×¸ü¯»ÖêÃÖ  (c) ÝÖÖê»Ö ÃÖßÛú  (d) ÝÖÖê ™ãü  
 

126. “ÖµÖ×®ÖŸÖ ÃÖê»ÃÖ Ûêú ŸÖã¸ü®ŸÖ ²ÖÖ¤ü “ÖµÖ×®ÖŸÖ ÃÖê»ÃÖ ÛúÖ µÖÖêÝÖ ¯ÖÏ¤üÙ¿ÖŸÖ Ûú¸ü®Öê Ûêú ×»Ö‹ ‹´Ö.‹ÃÖ.-‹ŒÃÖê»Ö 2007 Ûêú ×ÛúÃÖ ±úòŒ¿Ö®Ö 
ÛúÖ ¯ÖÏµÖÖêÝÖ ×ÛúµÖÖ •ÖÖŸÖÖ Æîü ? 

 (a) SUM  (b) TOTAL  (c) ADD  (d) ‡®Ö´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

127. ×®Ö´®Ö ´Öë ÃÖê ‹ŒÃÖê»Ö Ûúß ×ÛúÃÖ Ûú´ÖÖÞ›ü «üÖ¸üÖ ›üÖ™üÖ Ûêú ÛúÖò»Ö´Ö ÛúÖê ¯ÖÓ×ŒŸÖ ´Öë ²Ö¤ü»ÖÖ •ÖÖŸÖÖ Æîü ? 
 (a) Ûú™ü ‹Þ›ü ¯ÖêÃ™ü  (b) ¯ÖêÃ™ü Ã¯Öê¿Ö»Ö → ™ÒüÖÓÃÖ¯ÖÖê•Ö  
 (c) †Öê×¸ü‹®™êü¿Ö®Ö  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

128. ‹ŒÃÖê»Ö 2007 ÛúÖ ÛúÖî®Ö ÃÖÖ ±úòŒ¿Ö®Ö ‹Ûú ÃÖê»Ö Ûêú Ûîú¸êüŒ™üÃÖÔ Ûúß ÃÖÓÜµÖÖ ×ÝÖ®Ö ÃÖÛúŸÖÖ Æîü ? 
 (a) Length  (b) LGT  (c) LT  (d) LEN  
 

129. Ûú´ÖÖÞ›ü Home→Edit→Fill Across Worksheet of Excel 2007 Ûêú¾Ö»Ö ŸÖ³Öß ÃÖ×ÛÎúµÖ ÆüÖêŸÖÖ Æîü •Ö²Ö  
 (a) ‹Ûú ¿Öß™ü “ÖµÖ×®ÖŸÖ ÆüÖê …   (b) •Ö²Ö ²ÖÆãüŸÖ ÃÖß ¿Öß™ü “ÖµÖ×®ÖŸÖ ÆüÖë …   
 (c) •Ö²Ö ÛúÖê‡Ô ³Öß ¿Öß™ü “ÖµÖ×®ÖŸÖ ®Ö ÆüÖë …   (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà … 
 

130. ‹´Ö.‹ÃÖ.-‹ŒÃÖê»Ö ´Öë ‹Ûú ×®Ö×¿“ÖŸÖ ¿ÖŸÖÔ (criteria) ÛúÖê ¯ÖæÞÖÔ Ûú¸ü®Öê ¾ÖÖ»Öß Ûêú¾Ö»Ö ˆ®Ö ¯ÖÏ×¾Ö×Â™üµÖÖë Ûúß ÃÖæ“Öß ¯ÖÏÖ¯ŸÖ Ûúß •ÖÖ 
ÃÖÛúŸÖß Æîü ______ ´Öê®µÖæ «üÖ¸üÖ  

 (a) ›üÖ™üÖ → ÃÖÖò™Ôü  (b) ›üÖ™üÖ → ×±ú»™ü¸ü  
 (c) ±úÖò¸ü´Öê™ü → ¿Öß™ü  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

131. †Ö¯Ö ×ÛúÃÖß ¯ÖÏ•Öê®™êü¿Ö®Ö ÛúÖê ®ÖµÖê ±úÖ‡»Ö ®Öê´Ö Ûêú †®ŸÖÝÖÔŸÖ ÛîúÃÖê ÃÖê¾Ö (Save) Ûú¸ëüÝÖê ? 
 (a) ±úÖ‡»Ö ´Öê®µÖæ ÛúÖê Select Ûú¸üÛêú Save As “Öã®ÖŸÖê Æïü …  
 (b) •Ö²Ö †Ö¯Ö ¯ÖÖ¾Ö¸ü ¯¾ÖÖ‡Ó™ü ÛúÖ “Öã®ÖÖ¾Ö Ûú¸üŸÖê Æïü ±úÖ‡»Ö Ã¾ÖµÖÓ save ÆüÖê •ÖÖŸÖß Æîü …   
 (c) ±úÖ‡»Ö ´Öê®µÖæ ÛúÖê  Select Ûú¸üÛêú Save ÛúÖ “Öã®ÖÖ¾Ö Ûú¸üŸÖê Æïü …  
 (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

132. ‹Ûú Ûîú¸êüŒ™ü¸ü •ÖÖê ²ÖêÃÖ»ÖÖ‡®Ö Ûêú ‰ú¯Ö¸ü ”ûÖê™êü †ÖÛúÖ¸ü ´Öë ÆüÖêŸÖÖ Æîü, ˆÃÖê ÛúÆüŸÖê Æïü 
 (a) †Öˆ™ü »ÖÖ‡®›ü  (b) ¸êü•›ü  (c) ÃÖã¯Ö¸ü-×ÃÛÎú¯™ü  (d) ÃÖ²Ö-×ÃÛÎú¯™ü  
 

133. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ¯ÖÏ•Öê®™êü¿Ö®Ö ÝÖÏÖ×±úŒÃÖ ÃÖÖò°™ü¾ÖêµÖ¸ü Æîü ? 
 (a) ‹´Ö.‹ÃÖ.-×¾Ö®›üÖê  (b) ‹´Ö.‹ÃÖ.-¯ÖÖ¾Ö¸ü ¯¾ÖÖò‡Ó™ü 
 (c) ‹´Ö.‹ÃÖ.-‹ŒÃÖê»Ö  (d) ‹´Ö.‹ÃÖ.-¾Ö›Ôü  
 

134. ÛúÖî®Ö ÃÖÖ ×®Ö¤ìü¿Ö †Ö¯ÖÛúÖê †¯Ö®Öê ¯ÖÏÃŸÖãŸÖßÛú¸üÞÖ Ûêú ¯ÖÏ£Ö´Ö Ã»ÖÖ‡›ü ¯Ö¸ü »Öê •ÖÖŸÖÖ Æîü ? 
 (a) ¯Öê•Ö †¯Ö  (b) ×¿Ö°™ü + ÆüÖê´Ö  (c) †Ö»™ü + ÆüÖê´Ö  (d) ÛÓú™ÒüÖê»Ö + ÆüÖê´Ö  
 

135. ¯ÖÖ¾Ö¸ü ¯¾ÖÖò‡Ó™ü ´Öë †Ö¯Ö †¯Ö®Öê ¯ÖÏ•Öê®™êü¿Ö®Ö Ûêú ÃÖÖ£Ö ®Ö‡Ô Ã»ÖÖ‡›ü _______ Ûêú «üÖ¸üÖ •ÖÖê›Ìü ÃÖÛúŸÖê Æïü …  
 (a) Insert → Slide  (b) Insert → New Slide  
 (c) Format → New Slide  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

136. ¯ÖÏ•Öê®™êü¿Ö®Ö ´Öë ±úÖò®™ü ÃÖÖ‡•Ö ÛúÖê Ûú´Ö Ûú¸ü®Öê ÆêüŸÖã _______ ¿ÖÖ™ÔüÛú™ü ¯ÖÏµÖãŒŸÖ ÆüÖêŸÖÖ Æîü …  
 (a) Ctrl + Shift + >  (b) Ctrl + Shift + <  
 (c) Ctrl + >  (d) Ctrl + <  
 

137. †¯Ö®Öê †Öò™üÖêÛú¸êüŒ™ü ˆ¯ÖµÖÖêÝÖ ×®Ö•ÖßÛéúŸÖ Ûú¸ü®Öê Ûêú ×»Ö‹ ¯ÖÏµÖÖêÝÖ Ûú¸üŸÖê Æïü  
 (a) Tools → AutoCorrect  (b) Insert → AutoCorrect  
 (c) Format → AutoCorrect  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
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138. Ctrl + H is used to  
 (a) Invoke find dialog box (b) Invoke replace dialog box 
 (c) Both (a) and (b) (d) None of the above  
 

139. To add a chart to the slide use  
 (a) Insert  → Chart (b) Tools  → Chart 
 (c) File  → Chart (d) None of the above 
 

140. Which of the following allows you to select more than one slide in a presentation ? 
 (a) Alt + Click each slide (b) Shift + drag each slide 
 (c) Shift + click each slide (d) Ctrl + click each slide 
 

141. The properties of relational tables are  
 (a) each row is unique (b) each column has a unique name 
 (c) both (a) and (b) (d) None of the above 
 

142. In MS-Access, the text data type may contain maximum characters of  
 (a) 255 characters   (b) 256 characters 
 (c) 1064 characters  (d) No limit 
 

143. In MS-Access size of Yes No field is always 
 (a) 1 bit (b) 1 byte (c) 1 character (d) 1 GB 
 

144. Which of the following database objects can you import from one Microsoft Access 
database to another ? 

 (a) Queries (b) Tables (c) Forms (d) All of these 
 

145. In a database table, the category of information is called  
 (a) Tuple (b) Field (c) Record (d) All of these 
 

146. Data can be imported into Access database from  
 (a) Word Files   (b) Excel Files  
 (c) HTML Files   (d) PowerPoint Files 
 

147. Which of the field has width 8 bytes in MS-Access ? 
 (a) Memo (b) Number (c) Date / Time (d) Hyperlink 
 

148. Which one is not the way to create reports in MS-Access ? 
 (a) Design view (b) Data form (c) Report wizard (d) Label wizard 
 

149. In table design view, which key can be used to switch between the field names and 
properties panels ? 

 (a) F3 (b) F4 (c) F5 (d) F6 
 

150. Which of the following file type indicates the file is an MS-Access document ? 
 (a) .msw (b) .wor (c) .accdb (d) .wrd 



EFP 21 Series-A 

138. Ctrl + H ¯ÖÏµÖãŒŸÖ ÆüÖêŸÖÖ Æîü – 
 (a) Invoke Find dialogbox  (b) Invoke Replace dialogbox   
 (c) (a) ‹¾ÖÓ (b) ¤üÖê®ÖÖë  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

139. Ã»ÖÖ‡›ü ´Öë “ÖÖ™Ôü •ÖÖê›Ìü®Öê ÆêüŸÖã _______ ¯ÖÏµÖãŒŸÖ ÆüÖêŸÖÖ Æîü … 
 (a) Insert → Chart  (b) Tools → Chart  
 (c) File → Chart  (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

140. ¯ÖÏ•Öê®™êü¿Ö®Ö ´Öë ‹Ûú ÃÖê †×¬ÖÛú Ã»ÖÖ‡›ü ÛúÖê “Öã®Ö®Öê Ûêú ×»Ö‹ ×®Ö´®Ö×»Ö×ÜÖŸÖ ´Öë ÃÖê ÛúÖî®Ö †Ö¯ÖÛúÖê †®Öã´Ö×ŸÖ ¤êüŸÖÖ Æîü ? 
 (a) Alt + click each slide  (b) Shift + drag each slide  
 (c) Shift + click each slide  (d) Ctrl + click each slide  
 

141. ÃÖ´²Ö®¬Ö¯Ö¸üÛú ŸÖÖ×»ÖÛúÖ†Öë Ûúß ×¾Ö¿ÖêÂÖŸÖÖ‹Ñ ÆüÖêŸÖß Æïü  
 (a) ¯ÖÏŸµÖêÛú ¯ÖÓ×ŒŸÖ †×«üŸÖßµÖ ÆüÖêŸÖß Æîü …  (b) ¯ÖÏŸµÖêÛú ÃŸÖ´³Ö ÛúÖ ®ÖÖ´Ö †×«üŸÖßµÖ ÆüÖêŸÖÖ Æîü …   
 (c) (a) †Öî¸ü (b) ¤üÖê®ÖÖë (d) ˆ¯Ö¸üÖêŒŸÖ ´Öë ÃÖê ÛúÖê‡Ô ®ÖÆüà   
 

142. ‹´Ö.‹ÃÖ.-‹ŒÃÖêÃÖ ´Öë, ™êüŒÃ™ü ›üÖ™üÖ ™üÖ‡¯Ö †×¬ÖÛúŸÖ´Ö _______ Ûîú¸êüŒ™üÃÖÔ ÛúÖ ÆüÖê ÃÖÛúŸÖÖ Æîü …  
 (a) 255 (b) 256 (c) 1064 (d) ÛúÖê‡Ô ÃÖß´ÖÖ ®ÖÆüà   
 

143. ‹´Ö.‹ÃÖ.-‹ŒÃÖêÃÖ ´Öë, Yes No ×±ú»›ü ÛúÖ †ÖÛúÖ¸ü Æü´Öê¿ÖÖ ÆüÖêŸÖÖ Æîü  
 (a) 1 ×²Ö™ü  (b) 1 ²ÖÖ‡™ü  (c) 1 Ûîú¸êüŒ™ü¸ü  (d) 1 •Öß.²Öß.   
 

144. ‹Ûú ´ÖÖ‡ÛÎúÖêÃÖÖò°™ü ‹ŒÃÖêÃÖ ›üÖ™üÖ ²ÖêÃÖ ÃÖê ¤æüÃÖ¸êü ›üÖ™üÖ²ÖêÃÖ ´Öë †ÖµÖÖŸÖ Ûú¸ü®Öê Ûêú ×»Ö‹ ×®Ö´®Ö×»Ö×ÜÖŸÖ ´Öë ÛúÖî®Ö ÃÖÖ ›üÖ™üÖ²ÖêÃÖ 
†Öò²•ÖêŒ™ü ¯ÖÏµÖãŒŸÖ ×ÛúµÖÖ •ÖÖŸÖÖ Æîü ? 

 (a) Œ¾Öê¸üß•Ö  (b) ™êü²Ö»ÃÖ  (c) ±úÖò´ÃÖÔ  (d) µÖê ÃÖ³Öß   
 

145. ›üÖ™üÖ²ÖêÃÖ ™êü²Ö»Ö ´Öë ÃÖæ“Ö®ÖÖ Ûêú ¾ÖÝÖáÛú¸üÞÖ ÛúÖê ÛúÆüŸÖê Æïü  
 (a) ™ü¯Ö»Ö  (b) ×±ú»›ü  (c) ×¸üÛúÖò›Ôü  (d) µÖê ÃÖ³Öß   
 

146. ›üÖ™üÖ ÛúÖê _______ ÃÖê ‹ŒÃÖêÃÖ ›üÖ™üÖ²ÖêÃÖ ´Öë †ÖµÖÖ×ŸÖŸÖ Ûú¸ü ÃÖÛúŸÖê Æïü …  
 (a) ¾Ö›Ôü ±úÖ‡»ÃÖ  (b) ‹ŒÃÖê»Ö ±úÖ‡»ÃÖ  
 (c) ‹“Ö.™üß.‹´Ö.‹»Ö. ±úÖ‡»ÃÖ  (d) ¯ÖÖ¾Ö¸ü ¯¾ÖÖò‡Ó™ü ±úÖ‡»ÃÖ  
 

147. ‹´Ö.‹ÃÖ.-‹ŒÃÖêÃÖ ´Öë ×®Ö´®Ö ´Öë ÃÖê ×ÛúÃÖÛúÖ †ÖÛúÖ¸ü 8 ²ÖÖ‡™ü ÆüÖêŸÖÖ Æîü ? 
 (a) ´Öê´ÖÖê  (b) ®Ö´²Ö¸ü  (c) ›êü™ü/™üÖ‡´Ö  (d) ÆüÖ‡¯Ö¸üØ»ÖÛú 
 

148. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ÃÖÖ ŸÖ¸üßÛúÖ ‹´Ö.‹ÃÖ.-‹ŒÃÖêÃÖ ´Öë ×¸ü¯ÖÖê™Ôü ²Ö®ÖÖ®Öê ´Öë ®ÖÆüà Æîü ? 
 (a) ×›ü•ÖÖ‡®Ö ¾µÖæ  (b) ›üÖ™üÖ ±úÖ´ÖÔ  
 (c) ×¸ü¯ÖÖê™Ôü ×¾Ö•ÖÖ›Ôü  (d) »Öê²Ö»Ö ×¾Ö•ÖÖ›Ôü  
 

149. ™êü²Ö»Ö ×›ü•ÖÖ‡®Ö ¾µÖæ ´Öë ×±ú»›ü ®Öê´Ö ¾Ö ¯ÖÏÖò¯Ö™üá•Ö ¯Öî®Ö»ÃÖ Ûêú ²Öß“Ö ´Öë ×Ã¾Ö“Ö Ûú¸ü®Öê Ûêú ×»Ö‹ ÛúÖî®Ö ÃÖß ÛãÓú•Öß ÛúÖ ¯ÖÏµÖÖêÝÖ ×ÛúµÖÖ •ÖÖ 
ÃÖÛúŸÖÖ Æîü ? 

 (a) F3  (b) F4  (c) F5  (d) F6  
 

150. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ÃÖÖ ±úÖ‡»Ö ¯ÖÏÛúÖ¸ü µÖÆü ‡Ó×ÝÖŸÖ Ûú¸üŸÖÖ Æîü ×Ûú ±úÖ‡»Ö ‹Ûú ‹´Ö.‹ÃÖ.-‹ŒÃÖêÃÖ ›üÖòŒµÖæ´Öë™ü Æîü ? 
 (a) .msw  (b) .wor  (c) .accdb  (d) .wrd  
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PART – III 
GENERAL STUDIES RELATED TO STATE   

151. The largest glacier in Uttarakhand is  
 (a) Sunder Dhunga (b) Milam 
 (c) Kafni (d) Gangotri 
 

152. Initiator of ‘Dola Palke’ movement in Uttarakhand is  
 (a) Hemwati Nandan Bahuguna (b) Bhakta Darshan 
 (c) Premlal Vaid (d) Jayanand Bharti 
 

153. When ‘Garhwal’ word came in existence for ‘Garhwal’ ? 
 (a) 1815 A.D. (b) 1515 A.D. (c) 1820 A.D. (d) 1279 A.D. 
 

154. Maula Ram was a  
 (a) Poet (b) Doctor (c) Social worker (d) Freedom fighter 
 

155. Who was the founder Editor of the newspaper “Shakti” in Almora ? 
 (a) Ram Singh Dhoni  (b) Badri Datt Pandey 
 (c) Prayag Joshi (d) Victor Mohan Joshi 
 

156. ‘Barahat’ is the ancient name of  
 (a) Srinagar (b) Uttarkashi (c) Rudraprayag (d) Joshimath 
 

157. Raj Bhawan of Nainital was established in the year  
 (a) 1860 (b) 1875 (c) 1879 (d) 1890 
 

158. Who is known as ‘Kumaun Kesri’ ? 
 (a) Hargovind Pant (b) Pt. Badri Datt Pandey 
 (c) Kalu Mahra (d) Mohan Singh Mehta 
 

159. Which one of the following is not a ‘Folk Dance’ of Uttarakhand ? 
 (a) Chaunphala (b) Jhumaila (c) Chholia (d) Giddha 
 

160. In which year the “Kumaun” came under the Gorkha Rule ?  
 (a) 1790 (b) 1815 (c) 1810 (d) 1804 
 

161. Maximum number of the sugarmills are present in which district of Uttarakhand ? 
 (a) Dehradun (b) Haridwar 
 (c) Udham Singh Nagar (d) None of the above 
 

162. The total forest covered area in Uttarakhand is about  
 (a) 68.79% (b) 64.79% (c) 63.19% (d) 59.29% 
 

163. In which year Tehri estate was merged into Republic of India ? 
 (a) 1945 (b) 1947 (c) 1949 (d) 1951 
 

164. Kalagarh Dam is constructed on 
 (a) Ramganga river (b) Bhagirathi river 
 (c) Sharda river (d) Yamuna river 
 

165. Which place among the following is called as the ‘Bardoli of Kumaun” ? 
 (a) Nainital (b) Ranikhet (c) Salt (d) Almora 
 

166. ‘Milasara Tax’ in Tehri estate was levied on 
 (a) Irrigated land (b) Pastures 
 (c) Reunion of divorced couples (d) Seasonal crops 
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³ÖÖÝÖ ³ÖÖÝÖ ³ÖÖÝÖ ³ÖÖÝÖ ----    IIIIIIIIIIII 
¸üÖ•µÖ ÃÖê ÃÖÓ²ÖÓ×¬ÖŸÖ ÃÖÖ´ÖÖ®µÖ ¸üÖ•µÖ ÃÖê ÃÖÓ²ÖÓ×¬ÖŸÖ ÃÖÖ´ÖÖ®µÖ ¸üÖ•µÖ ÃÖê ÃÖÓ²ÖÓ×¬ÖŸÖ ÃÖÖ´ÖÖ®µÖ ¸üÖ•µÖ ÃÖê ÃÖÓ²ÖÓ×¬ÖŸÖ ÃÖÖ´ÖÖ®µÖ †¬µÖµÖ®Ö†¬µÖµÖ®Ö†¬µÖµÖ®Ö†¬µÖµÖ®Ö 

151. ˆ¢Ö¸üÖÜÖÞ›ü Ûúß ÃÖ²ÖÃÖê ²Ö›Ìüß ×Æü´ÖÖ®Öß (×Æü´Ö®Ö¤ü) Æîü  
 (a) ÃÖã®¤ü¸ü œãÓüÝÖÖ  (b) ×´Ö»Ö´Ö  (c) ÛúÖ±ú®Öß  (d) ÝÖÓÝÖÖê¡Öß  
 

152. ˆ¢Ö¸üÖÜÖÞ›ü ´Öë ‘›üÖê»ÖÖ ¯ÖÖ»ÖÛúß’  †Ö®¤üÖê»Ö®Ö Ûêú ¯ÖÏÞÖêŸÖÖ Æïü  
 (a) Æêü´Ö¾ÖŸÖß ®ÖÓ¤ü®Ö ²ÖÆãüÝÖãÞÖÖ  (b) ³ÖŒŸÖ ¤ü¿ÖÔ®Ö  
 (c) ¯ÖÏê´Ö»ÖÖ»Ö ¾Öîª  (d) •ÖµÖÖ®ÖÓ¤ü ³ÖÖ¸üŸÖß  
 

153. ‘ ÝÖœÌü¾ÖÖ»Ö’  Ûêú ×»ÖµÖê ÝÖœÌü¾ÖÖ»Ö ¿Ö²¤ü Ûú²Ö †×ÃŸÖŸ¾Ö ´Öë †ÖµÖÖ ? 
 (a) 1815 ‡Ô.  (b) 1515 ‡Ô.  (c) 1820 ‡Ô.  (d) 1279 ‡Ô.  
 

154. ´ÖÖî»ÖÖ¸üÖ´Ö £Öê, ‹Ûú  
 (a) Ûú×¾Ö  (b) ×“Ö×ÛúŸÃÖÛú  
 (c) ÃÖÖ´ÖÖ×•ÖÛú ÛúÖµÖÔÛú¢ÖÖÔ  (d) Ã¾ÖŸÖÓ¡ÖŸÖÖ ÃÖÓÝÖÏÖ´Ö ÃÖê®ÖÖ®Öß   
 

155. †»´ÖÖê›ÌüÖ Ûêú ‘¿Ö×ŒŸÖ’  †ÜÖ²ÖÖ¸ü Ûêú ÃÖÓÃ£ÖÖ¯ÖÛú ÃÖ´¯ÖÖ¤üÛú ÛúÖî®Ö £Öê ? 
 (a) ¸üÖ´ÖØÃÖÆü ¬ÖÖê®Öß  (b) ²Ö¦üß¤ü¢Ö ¯ÖÖÞ›êü  (c) ¯ÖÏµÖÖÝÖ •ÖÖê¿Öß  (d) ×¾ÖŒ™¸ü ´ÖÖêÆü®Ö •ÖÖê¿Öß  
 

156. ‘ ²ÖÖ›ÌüÖÆüÖ™ü’ ¯ÖÏÖ“Öß®Ö ®ÖÖ´Ö Æîü  
 (a) ÁÖß®ÖÝÖ¸ü ÛúÖ  (b) ˆ¢Ö¸üÛúÖ¿Öß ÛúÖ   (c) ¹ý¦ü¯ÖÏµÖÖÝÖ ÛúÖ   (d) •ÖÖê¿Öß´Öšü ÛúÖ  
 

157. ®Öî®ÖßŸÖÖ»Ö Ûêú ‘ ¸üÖ•Ö³Ö¾Ö®Ö’  Ûúß Ã£ÖÖ¯Ö®ÖÖ Ûúß ÝÖ‡Ô £Öß, ¾ÖÂÖÔ 
 (a) 1860 ´Öë  (b) 1875 ´Öë  (c) 1879 ´Öë  (d) 1890 ´Öë   
 

158. ‘Ûãú´ÖÖ‰Ñú ÛêúÃÖ¸üß’  Ûêú ®ÖÖ´Ö ÃÖê ×ÛúÃÖê •ÖÖ®ÖÖ •ÖÖŸÖÖ Æîü ? 
 (a) Æü¸üÝÖÖêØ¾Ö¤ü ¯ÖÓŸÖ  (b) ¯ÖÓ. ²Ö¦üß¤ü¢Ö ¯ÖÖÞ›êü  (c) ÛúÖ»Öæ ´ÖÖÆü¸üÖ  (d) ´ÖÖêÆü®ÖØÃÖÆü ´ÖêÆüŸÖÖ  
 

159. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ‹Ûú ˆ¢Ö¸üÖÜÖÞ›ü ÛúÖ »ÖÖêÛú®ÖéŸµÖ ®ÖÆüà Æîü ? 
 (a) “ÖÖï±ú»ÖÖ  (b) —Öã´Öê»ÖÖ  (c) ”ûÖê×»ÖµÖÖ  (d) ×ÝÖ¨üÖ  
 

160. ‘Ûãú´ÖÖµÖæÑ’  ÝÖÖê¸üÜÖÖ ¿ÖÖÃÖ®Ö Ûêú †Ö¬Öß®Ö Ûú²Ö †ÖµÖÖ ? 
 (a) 1790 ´Öë  (b) 1815 ´Öë  (c) 1810 ´Öë  (d) 1804 ´Öë  
 

161. ˆ¢Ö¸üÖÜÖÓ›ü Ûêú ×ÛúÃÖ •Ö®Ö¯Ö¤ü ´Öë ÃÖ¾ÖÖÔ×¬ÖÛú “Öß®Öß ×´Ö»Öë Æïü ? 
 (a) ¤êüÆü¸üÖ¤æü®Ö ´Öë   (b) Æü×¸ü«üÖ¸ü ´Öë   (c) ‰ú¬Ö´ÖØÃÖÆü ®ÖÝÖ¸ü ´Öë   (d) ‡®Ö´Öë ÃÖê ×ÛúÃÖß ´Öë ®ÖÆüà   
 

162. ˆ¢Ö¸üÖÜÖÞ›ü ÛúÖ Ûãú»Ö ¾Ö®ÖÖ“”ûÖ×¤üŸÖ õÖê¡Ö »ÖÝÖ³ÖÝÖ Æîü  
 (a) 68.79%  (b) 64.79%  (c) 63.19%  (d) 59.29%  
 

163. ×™üÆü¸üß ×¸üµÖÖÃÖŸÖ ÛúÖ ³ÖÖ¸üŸÖßµÖ ÝÖÞÖ¸üÖ•µÖ ´Öë ×¾Ö»ÖµÖ ×ÛúÃÖ ¾ÖÂÖÔ ´Öë Æãü†Ö £ÖÖ ? 
 (a) 1945 ´Öë  (b) 1947 ´Öë  (c) 1949 ´Öë  (d) 1951 ´Öë  
 

164. ÛúÖ»ÖÖÝÖœÌü ²ÖÖÑ¬Ö ÛúÖ ×®Ö´ÖÖÔÞÖ ×ÛúµÖÖ ÝÖµÖÖ Æîü  
 (a) ¸üÖ´ÖÝÖÓÝÖÖ ®Ö¤üß ¯Ö¸ü   (b) ³ÖÖÝÖß¸ü£Öß ®Ö¤üß ¯Ö¸ü  (c) ¿ÖÖ¸ü¤üÖ ®Ö¤üß ¯Ö¸ü  (d) µÖ´Öã®ÖÖ ®Ö¤üß ¯Ö¸ü   
 

165. ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ÃÖê Ã£ÖÖ®Ö ÛúÖê ‘Ûãú´ÖÖµÖæÑ Ûúß ²ÖÖ¸ü¤üÖê»Öß’ ÛúÆüÖ ÝÖµÖÖ ? 
 (a) ®Öî®ÖßŸÖÖ»Ö  (b) ¸üÖ®ÖßÜÖêŸÖ  (c) ÃÖ»™ü  (d) †»´ÖÖê›ÌüÖ  
 

166. ‘ ×´Ö»ÖÖÃÖÖ¸üÖ Ûú¸ü’ – ×™üÆü¸üß ×¸üµÖÖÃÖŸÖ ´Öë ×»ÖµÖÖ •ÖÖŸÖÖ £ÖÖ  
 (a) ØÃÖ×“ÖŸÖ ³Öæ×´Ö ¯Ö¸ü   (b) “Ö¸üÖÝÖÖÆüÖë ¯Ö¸ü  
 (c) ŸÖ»ÖÖÛú¿Öã¤üÖ ¤Óǖ Ö×¢ÖµÖÖë Ûêú ¯Öã®Ö:ÃÖÓ²ÖÓ¬Ö Ã£ÖÖ×¯ÖŸÖ ÆüÖê®Öê ¯Ö ü̧  (d) ´ÖÖîÃÖ´Öß ±úÃÖ»ÖÖë ¯Ö¸ü   



Series-A 24 EFP 

167. The Kaundali festival of Chaundas is celebrated by 
 (a) Shaukas (b) Tolchas (c) Jaads (d) Boxas 
 

168. Who planted apple orchard in Harsil ? 
 (a) S.G. Scott (b) Admond Hillari (c) Jim Corbett (d) Fredrick Wilson 
 

169. Which tribe among the following of Uttarakhand worship ‘Mahasu Devta’ ? 
 (a) Tharu (b) Jaunsari (c) Boxa (d) Raji 
 

170. Match the following and mark the correct answer from the codes given below : 
   Glacier        District  

A. Pindari 1. Pithoragarh 
B. Milam 2. Bageshwar 
C. Gangotri 3. Bageshwar 
D. Kafni 4. Uttarkashi 

 Codes : 
  A B C D 
 (a) 1 2 3 4  
 (b) 2 1 4 3  
 (c) 4 3 2 1  
 (d) 2 1 3 4  
 

171. On which date the inauguration of the session of Legislative Assembly of Uttarakhand for 
the first time took place at Gairsain ? 

 (a) November 03, 2012 (b) January 14, 2013 
 (c) November 09, 2013 (d) June 09, 2014 
 

172. Which of the following is the governing body of Rural Panchayat System ? 
 (a) Gram Sabha (b) Gram Panchayat (c) Block Panchayat (d) Zila Panchayat 
 

173. The date of implementation of the special integrated industrial promotion policy for hilly 
and remote areas of Uttarakhand is  

 (a) April 01, 2000 (b) April 01, 2005 (c) April 01, 2008 (d) April 01, 2010 
 

174. Which one among the following rivers of Uttarakhand is not a snow fed river ? 
 (a) Tons (b) Bhilangna 
 (c) Ramganga (West) (d) Goriganga 
 

175. Match the following and select the correct answer from the codes given below : 
       Glacier       River 

A. Satopanth  1. Alaknanda 
B. Milam 2. Gori 
C. Khatling 3. Bhilangna 
D. Pindari 4. Pindar 

 Codes : 
  A B C D 
 (a) 1 2 3 4 
 (b) 4 3 2 1 
 (c) 2 1 4 3 
 (d) 3 4 1 2  
 

176. The famous ‘Baghnath’ temple in Uttarakhand is situated at 
 (a) Gopeshwar (b) Bageshwar (c) Jageshwar (d) Someshwar 
 

177. Meaning of ‘Talaun Land’ is  
 (a) Stoney land (b) Barren land (c) Forest land (d) Irrigated land 
 

178. ‘Green Day’ is celebrated in Uttarakhand on which day ? 
 (a) 3rd July (b) 5th July (c) 8th July (d) 15th July 
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167. “ÖÖï¤üÖÃÖ ÛúÖ ÛãÓú›üÖ»Öß ¯Ö¾ÖÔ ´Ö®ÖÖŸÖê Æïü  
 (a) ¿ÖÖîÛúÖ  (b) ŸÖÖê»”ûÖ  (c) •ÖÖ›Ìü  (d) ²ÖÖêŒÃÖÖ  
 

168. ÆüÙÂÖ»Ö ´Öë ÃÖê²Ö Ûêú ²ÖÖÝÖÖ®Ö ÛúÖê ×ÛúÃÖ®Öê ¸üÖê×¯ÖŸÖ ×ÛúµÖÖ ? 
 (a) ‹ÃÖ.•Öß. ÃÛúÖò™ü  (b) ‹›ü´Ö®›ü ×Æü»Öî¸üß  (c) ×•Ö´Ö ÛúÖ²Öì™ü  (d) ±Ïêú×›üÛú ×¾Ö»ÃÖ®Ö  
 

169. ˆ¢Ö¸üÖÜÖÞ›ü Ûúß ×®Ö´®Ö ´Öë ÃÖê ÛúÖî®Ö ÃÖß •Ö®Ö•ÖÖ×ŸÖ ‘ ´ÖÆüÖÃÖæ ¤êü¾ÖŸÖÖ’  Ûúß ¯Öæ•ÖÖ Ûú¸üŸÖß Æîü ? 
 (a) £ÖÖºþ  (b) •ÖÖî®ÖÃÖÖ¸üß  (c) ²ÖÖêŒÃÖÖ  (d) ¸üÖ•Öß  
 

170. ×®Ö´®Ö ÛúÖê ÃÖã´Öê×»ÖŸÖ Ûú¸ü, ®Öß“Öê ×¤üµÖê ÝÖµÖê Ûæú™üÖë ÃÖê ÃÖÆüß ˆ¢Ö¸ü “Öã×®ÖµÖê : 
        Ý»Öê×¿ÖµÖ¸üÝ»Öê×¿ÖµÖ¸üÝ»Öê×¿ÖµÖ¸üÝ»Öê×¿ÖµÖ¸ü        •Ö®Ö¯Ö¤ü•Ö®Ö¯Ö¤ü•Ö®Ö¯Ö¤ü•Ö®Ö¯Ö¤ü    
 A. ×¯Ö®›üÖ¸üß 1. ×¯Ö£ÖÖê¸üÖÝÖœÌü 
 B. ×´Ö»Ö´Ö 2. ²ÖÖÝÖê¿¾Ö¸ü 
 C. ÝÖÓÝÖÖê¡Öß 3. ²ÖÖÝÖê¿¾Ö¸ü 
 D. Ûú±ú®Öß 4. ˆ¢Ö¸üÛúÖ¿Öß 
    Ûæú™ü :Ûæú™ü :Ûæú™ü :Ûæú™ü :    
  A B C D 
 (a) 1 2 3 4  
 (b) 2 1 4 3  
 (c) 4 3 2 1  
 (d) 2 1 3 4  
 

171. ×ÛúÃÖ ×ŸÖ×£Ö ÛúÖê ÝÖî¸üÃÖîÞÖ ´Öë ¯ÖÏ£Ö´Ö ²ÖÖ¸ü ˆ¢Ö¸üÖÜÖÞ›ü ×¾Ö¬ÖÖ®Ö ÃÖ³ÖÖ Ûêú ÃÖ¡Ö ÛúÖ ˆ¤Ëü‘ÖÖ™ü®Ö Æãü†Ö £ÖÖ ? 
 (a) 03 ®Ö¾Ö´²Ö¸ü, 2012  (b) 14 •Ö®Ö¾Ö¸üß, 2013  
 (c) 09 ®Ö¾Ö´²Ö¸ü, 2013  (d) 09 •Öæ®Ö, 2014  
 

172. ×®Ö´®Ö×»Ö×ÜÖŸÖ ´Öë ÃÖê ÛúÖî®Ö ÃÖß ÝÖÏÖ´ÖßÞÖ ¯ÖÓ“ÖÖµÖŸÖ ¾µÖ¾ÖÃ£ÖÖ Ûúß ¯ÖÏ¿ÖÖÃÖ×®ÖÛú ‡ÛúÖ‡Ô Æîü ? 
 (a) ÝÖÏÖ´Ö ÃÖ³ÖÖ  (b) ÝÖÏÖ´Ö ¯ÖÓ“ÖÖµÖŸÖ  (c) õÖê¡Ö ¯ÖÓ“ÖÖµÖŸÖ  (d) ×•Ö»ÖÖ ¯ÖÓ“ÖÖµÖŸÖ  
 

173. ˆ¢Ö¸üÖÜÖÞ›ü ´Öë ¯Ö¾ÖÔŸÖßµÖ ¾Ö ÃÖã¤æü¸ü¾Ö¢Öá õÖê¡ÖÖë Ûêú ×»Ö‹ ×¾Ö¿ÖêÂÖ ‹ÛúßÛéúŸÖ †ÖîªÖê×ÝÖÛú ¯ÖÏÖêŸÃÖÖÆü®Ö ®Öß×ŸÖ »ÖÖÝÖæ ÆüÖê®Öê Ûúß ×ŸÖ×£Ö Æîü : 
 (a) †¯ÖÏî»Ö 01, 2000  (b) †¯ÖÏî»Ö 01, 2005  (c) †¯ÖÏî»Ö 01, 2008  (d) †¯ÖÏî»Ö 01, 2010  
 

174. ˆ¢Ö¸üÖÜÖÞ›ü Ûúß ×®Ö´®Ö×»Ö×ÜÖŸÖ ®Ö×¤üµÖÖë ´Öë ÃÖê ÛúÖî®Ö ÃÖß ®Ö¤üß ×Æü´ÖÖ®Öß ¯ÖÖê×ÂÖŸÖ ®ÖÆüà Æîü ? 
 (a) ™üÖïÃÖ  (b) ×³Ö»ÖÓÝÖ®ÖÖ  (c) ¸üÖ´ÖÝÖÓÝÖÖ (¯Ö×¿“Ö´Ö)  (d) ÝÖÖê¸üßÝÖÓÝÖÖ  
 

175. ×®Ö´®Ö×»Ö×ÜÖŸÖ ÛúÖê ÃÖã´Öê×»ÖŸÖ Ûúß×•Ö‹ †Öî¸ü Ûæú™ ÃÖê ÃÖÆüß ˆ¢Ö¸ü “Öã×®ÖµÖê : 
        ×Æü´ÖÖ®Öß×Æü´ÖÖ®Öß×Æü´ÖÖ®Öß×Æü´ÖÖ®Öß                    ®Ö¤üß®Ö¤üß®Ö¤üß®Ö¤üß    
 A. ÃÖŸÖÖê¯ÖÓ£Ö 1. †»ÖÛú®Ö®¤üÖ 
 B. ×´Ö»Ö´Ö 2. ÝÖÖê¸üß 
 C. ÜÖŸÖØ»ÖÝÖ 3. ×³Ö»ÖÓÝÖ®ÖÖ 
 D. ×¯ÖÞ›üÖ¸üß 4. ×¯ÖÞ›ü¸ü 
    Ûæú™ü :Ûæú™ü :Ûæú™ü :Ûæú™ü :    
  A B C D 
 (a) 1 2 3 4  
 (b) 4 3 2 1 
 (c) 2 1 4 3 
 (d) 3 4 1 2 
 

176. ˆ¢Ö¸üÖÜÖÞ›ü ´Öë ¯ÖÏ×ÃÖ¨ü ‘ ²ÖÖ‘Ö®ÖÖ£Ö’  ´ÖÓ×¤ü¸ü ×Ã£ÖŸÖ Æîü  
 (a) ÝÖÖê¯Öê¿¾Ö¸ü ´Öë   (b) ²ÖÖÝÖê¿¾Ö¸ü ´Öë   (c) •ÖÖÝÖê¿¾Ö¸ü ´Öë   (d) ÃÖÖê´Öê¿¾Ö¸ü ´Öë   
 

177. ‘ ŸÖ»ÖÖ‰ú ³Öæ×´Ö’  ÛúÖ †£ÖÔ Æîü 
 (a) ¯Ö£Ö¸üß»Öß ³Öæ×´Ö  (b) ‰úÃÖ¸ü ³Öæ×´Ö  (c) ¾Ö®Ö ³Öæ×´Ö  (d) ØÃÖ×“ÖŸÖ ³Öæ×´Ö  
 

178. ˆ¢Ö¸üÖÜÖÞ›ü ´Öë ‘Æü×¸üŸÖ ×¤ü¾ÖÃÖ’  ×ÛúÃÖ ×¤ü®Ö ´Ö®ÖÖµÖÖ •ÖÖŸÖÖ Æîü ? 
 (a) 3 •Öã»ÖÖ‡Ô  (b) 5 •Öã»ÖÖ‡Ô  (c) 8 •Öã»ÖÖ‡Ô  (d) 15 •Öã»ÖÖ‡Ô  
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179. Name the district in Uttarakhand where ‘Naini-Saini’ aerodrome is being constructed. 
 (a) Almora (b) Uttarkashi (c) Chamoli (d) Pithoragarh 
 

180. Kalsi is famous for  
 (a) Historical stone inscription  (b) Religious centre 
 (c) Battle ground (d) Tourist place 
 

181. Name the place where IIM has been established in Uttarakhand. 
 (a) Dehradun (b) Haldwani (c) Kashipur (d) Rudrapur 
 

182. ‘Mana Pass’ is located between 
 (a) Chamoli and Tibet (b) Chamoli and Uttarkashi 
 (c) Chamoli and Pithoragarh (d) Pithoragarh and Champawat 
 

183. When natural calamity took place in Kedarnath Valley ? 
 (a) May, 2013 (b) June, 2013 (c) July, 2013 (d) August, 2013 
 

184. Which one among the following temples is located at the highest place of Uttarakhand ? 
 (a) Badrinath (b) Kedarnath (c) Rudranath (d) Tungnath 
 

185. Match the following and mark the correct answer from the codes given below : 
                Person       Specialization 
A. Mrinal Pande 1. Social movement 
B. Madhumita Bisht 2. Mountaineering 
C. Chandraprabha Aitwal 3. Badminton 
D. Gaura Devi 4. Journalism 

 Codes : 
  A B C D 
 (a) 1 2 3 4  
 (b) 4 3 2 1 
 (c) 3 4 1 2 
 (d) 2 1 4 3 
 

186. Total area of Tehri Dam (Swami Ramteerth Sagar) is 
 (a) 42 sq. km. (b) 45 sq. km. (c) 46 sq. km. (d) 48 sq. km. 
 

187. Match the following and select the correct answer from the codes given below : 
           Pass            Region 
A. Lipulekh 1. Uttarkashi – Tibet 
B. Barahoti 2. Pithoragarh – Tibet 
C. Trail pass 3. Chamoli – Pithoragarh 
D. Thangla 4. Bageshwar – Pithoragarh 

 Codes : 
  A B C D 
 (a) 1 2 3 4  
 (b) 2 3 4 1 
 (c) 3 2 1 4 
 (d) 2 3 1 4 
 
188. Who is known as the initiator of ‘Save Seed Movement’ ? 
 (a) Vandana Shiva (b) Sarpal Singh 
 (c) Shamsher Singh Bisht (d) Vijai Jaddhari 
 
189. Which Prayag is not correctly matched ? 
 (a) Devprayag – Alaknanda – Bhagirathi 
 (b) Nandprayag – Alaknanda – Nandakini 
 (c) Rudraprayag – Alaknanda – Mandakini 
 (d) Vishnuprayag – Gauriganga – Dhauliganga 
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179. ˆ¢Ö¸üÖÜÖÞ›ü ´Öë ‘ ®Öî®Öß-ÃÖî®Öß’  Æü¾ÖÖ‡Ô †øêü ÛúÖ ×®Ö´ÖÖÔÞÖ ×ÛúÃÖ ×•Ö»Öê ´Öë ÆüÖê ¸üÆüÖ Æîü ? 
 (a) †»´ÖÖê›ÌüÖ  (b) ˆ¢Ö¸üÛúÖ¿Öß  (c) “Ö´ÖÖê»Öß  (d) ×¯Ö£ÖÖê¸üÖÝÖœÌü  
 

180. ÛúÖ»ÖÃÖß ¯ÖÏ×ÃÖ¨ü Æîü  
 (a) ‹ê×ŸÖÆüÖ×ÃÖÛú ¯ÖÖÂÖÖÞÖ †×³Ö»ÖêÜÖ  (b) ¬ÖÖÙ´ÖÛú Ûêú®¦ü  
 (c) µÖã¨ü ³Öæ×´Ö  (d) ¯ÖµÖÔ™üÛú Ã£Ö»Ö  
 

181. ˆ¢Ö¸üÖÜÖÞ›ü ´Öë ¾ÖÆü Ã£ÖÖ®Ö ²ÖŸÖÖ‡‹ •ÖÆüÖÑ †Ö‡Ô.†Ö‡Ô.‹´Ö. Ûúß Ã£ÖÖ¯Ö®ÖÖ Ûúß ÝÖ‡Ô Æîü ? 
 (a) ¤êüÆü¸üÖ¤æü®Ö  (b) Æü»«üÖ®Öß  (c) ÛúÖ¿Öß¯Öã¸ü  (d) ¹ý¦ü¯Öã¸ü  
 

182. ‘ ´ÖÖÞÖÖ ¤ü¸üÖÔ’  ×ÛúÃÖÛêú ´Ö¬µÖ ´Öë ×Ã£ÖŸÖ Æîü ? 
 (a) “Ö´ÖÖê»Öß †Öî¸ü ×ŸÖ²²ÖŸÖ  (b) “Ö´ÖÖê»Öß †Öî¸ü ˆ¢Ö¸üÛúÖ¿Öß  
 (c) “Ö´ÖÖê»Öß †Öî¸ü ×¯Ö£ÖÖê¸üÖÝÖœÌü (d) ×¯Ö£ÖÖê¸üÖÝÖœÌü †Öî¸ü “Ö´¯ÖÖ¾ÖŸÖ  
 

183. Ûêú¤üÖ¸ü®ÖÖ£Ö ‘ÖÖ™üß ´Öë ¯ÖÏÖÛéú×ŸÖÛú ×¾Ö¯Ö¤üÖ Ûú²Ö ‘Ö×™üŸÖ Æãü‡Ô ? 
 (a) ´Ö‡Ô, 2013  (b) •Öæ®Ö, 2013  (c) •Öã»ÖÖ‡Ô, 2013  (d) †ÝÖÃŸÖ, 2013  
 

184. ×®Ö´®Ö×»Ö×ÜÖŸÖ ´ÖÓ×¤ü¸üÖë ´Öë ÃÖê ÛúÖî®Ö ÃÖÖ ‹Ûú ˆ¢Ö¸üÖÜÖÞ›ü ´Öë ÃÖ²ÖÃÖê ‰Ñú“Öê Ã£ÖÖ®Ö ¯Ö¸ü †¾Ö×Ã£ÖŸÖ Æîü ? 
 (a) ²Ö¦üß®ÖÖ£Ö  (b) Ûêú¤üÖ¸ü®ÖÖ£Ö  (c) ¹ý¦ü®ÖÖ£Ö  (d) ŸÖãÓÝÖ®ÖÖ£Ö  
 

185. ×®Ö´®Ö×»Ö×ÜÖŸÖ ÛúÖê ÃÖã´Öê×»ÖŸÖ Ûúß×•Ö‹ †Öî¸ü ®Öß“Öê ×¤ü‹ Ûæú™ ÃÖê ÃÖÆüß ˆ¢Ö¸ü “Öã×®ÖµÖê : 
        ¾µÖ×ŒŸÖ¾µÖ×ŒŸÖ¾µÖ×ŒŸÖ¾µÖ×ŒŸÖ                ×¾Ö¿ÖêÂÖ×¾Ö¿ÖêÂÖ×¾Ö¿ÖêÂÖ×¾Ö¿ÖêÂÖ––––ÖŸÖÖÖŸÖÖÖŸÖÖÖŸÖÖ    
 A. ´ÖéÞÖÖ»Ö ¯ÖÖÞ›êü 1. ÃÖÖ´ÖÖ×•ÖÛú †ÖÓ¤üÖê»Ö®Ö 
 B. ´Ö¬Öã×´ÖŸÖÖ ×²ÖÂ™ü 2. ¯Ö¾ÖÔŸÖÖ¸üÖêÆüÞÖ 
 C. “Ö®¦ü¯ÖÏ³ÖÖ ‹êŸÖ¾ÖÖ»Ö 3. ²Öî›ü×´Ö®™ü®Ö 
 D. ÝÖÖî¸üÖ ¤êü¾Öß 4. ¯Ö¡ÖÛúÖ×¸üŸÖÖ 
    Ûæú™ü :Ûæú™ü :Ûæú™ü :Ûæú™ü :    
  A B C D 
 (a) 1 2 3 4  
 (b) 4 3 2 1 
 (c) 3 4 1 2 
 (d) 2 1 4 3 
 

186. ×™üÆü¸üß ›îü´Ö (Ã¾ÖÖ´Öß ¸üÖ´ÖŸÖß£ÖÔ ÃÖÖÝÖ¸ü) ÛúÖ Ûãú»Ö õÖê¡Ö±ú»Ö Æîü  
 (a) 42 ¾ÖÝÖÔ ×Ûú´Öß  (b) 45 ¾ÖÝÖÔ ×Ûú´Öß  (c) 46 ¾ÖÝÖÔ ×Ûú´Öß  (d) 48 ¾ÖÝÖÔ ×Ûú´Öß  
 

187. ×®Ö´®Ö ÛúÖ ×´Ö»ÖÖ®Ö Ûú¸ëü ‹¾ÖÓ ÃÖÆüß ×¾ÖÛú»¯Ö ÛúÖ “ÖµÖ®Ö ®Öß“Öê ×¤ü‹ ÝÖ‹ Ûæú™üÖë ´Öë ÃÖê Ûú¸ëü : 
        ¤ü¸üÖÔ¤ü¸üÖÔ¤ü¸üÖÔ¤ü¸üÖÔ                        õÖê¡ÖõÖê¡ÖõÖê¡ÖõÖê¡Ö    
 A. ×»Ö¯Öã»ÖêÜÖ 1. ˆ¢Ö¸üÛúÖ¿Öß-×ŸÖ²²ÖŸÖ 
 B. ²ÖÖ›ÌüÖÆüÖêŸÖß 2. ×¯Ö£ÖÖê¸üÖÝÖœÌü-×ŸÖ²²ÖŸÖ 
 C. ™Òêü»Ö¯ÖÖÃÖ 3. “Ö´ÖÖê»Öß-×¯Ö£ÖÖê¸üÖÝÖœÌü 
 D. £ÖÖÓÝÖ»ÖÖ 4. ²ÖÖÝÖê¿¾Ö¸ü-×¯Ö£ÖÖê¸üÖÝÖœÌü 
    Ûæú™ü :Ûæú™ü :Ûæú™ü :Ûæú™ü :    
  A B C D 
 (a) 1 2 3 4  
 (b) 2 3 4 1 
 (c) 3 2 1 4 
 (d) 2 3 1 4 
 

188. ‘ ²Öß•Ö ²Ö“ÖÖ†Öê’ – †Ö®¤üÖê»Ö®Ö Ûêú ¯ÖÏÞÖêŸÖÖ Ûêú ºþ¯Ö ´Öë ×ÛúÃÖê •ÖÖ®ÖÖ •ÖÖŸÖÖ Æîü ? 
 (a) ¾ÖÓ¤ü®ÖÖ ×¿Ö¾ÖÖ  (b) ÃÖ¸ü¯ÖÖ»ÖØÃÖÆü  (c) ¿Ö´Ö¿Öê¸üØÃÖÆü ×²ÖÂ™ü  (d) ×¾Ö•ÖµÖ •Ö›Ìü¬ÖÖ¸üß  
 

189. ÛúÖî®Ö ÃÖÖ ¯ÖÏµÖÖÝÖ ÃÖã´Öê×»ÖŸÖ ®ÖÆüà Æîü ? 
 (a) ¤êü¾Ö¯ÖÏµÖÖÝÖ – †»ÖÛú®ÖÓ¤üÖ – ³ÖÖÝÖß¸ü£Öß  (b) ®Ö®¤ü¯ÖÏµÖÖÝÖ – †»ÖÛú®ÖÓ¤üÖ – ®Ö®¤üÖ×Ûú®Öß  
 (c) ¹ý¦ü¯ÖÏµÖÖÝÖ – †»ÖÛú®ÖÓ¤üÖ – ´ÖÓ¤üÖ×Ûú®Öß  (d) ×¾ÖÂÞÖã¯ÖÏµÖÖÝÖ – ÝÖÖî¸üßÝÖÓÝÖÖ – ¬ÖÖî»ÖßÝÖÓÝÖÖ 
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190. How many district of Uttarakhand touch the International Borders ? 
 (a) Two (b) Four (c) Six (d) Five 
 

191. Who is known as ‘Garh Kesri’ in Uttarakhand ? 
 (a) Ansuya Prasad Bahuguna (b) Bhakta Darshan 
 (c) Mukundi Lal (d) Keshar Singh Rawat 
 

192. What is the present name of Govisan ? 
 (a) Khatima (b) Kashipur (c) Rudrapur (d) Champawat 
 

193. What is Dhakar ? 
 (a) Tax (b) Tradition 
 (c) Foodgrains transportation (d) Name of the place 
 

194. Match the peaks with place and select the correct answer from the codes given below : 
           Peaks  Place 
A. Bandar Poonch 1. Chamoli 
B. Panchchuli 2. Uttarkashi 
C. Nanda Devi 3. Bageshwar 
D. Nanda Kot 4. Pithoragarh 

 Codes : 
  A B C D 
 (a) 1 2 3 4  
 (b) 4 3 2 1 
 (c) 3 2 4 1 
 (d) 1 4 3 2 
 

195. In which place “Dr. Pitamber Dutt Barthwal Hindi Academy” has been established ? 
 (a) Haridwar (b) Nainital (c) Dehradun (d) Rishikesh 
 

196. In which year the population and health policy of Uttarakhand was announced ? 
 (a) 2001 (b) 2002 (c) 2003 (d) 2004 
 

197. Who participated in the ‘Dandi March’ ? 
 (a) M.M. Kandpal (b) Jyoti Ram Kandpal 
 (c) Ansuya Prasad Bahuguna (d) Badri Datt Pandey 
 

198. In which place a training school was opened for the Satyagrahis in 1940 ? 
 (a) Ranikhet (Almora) (b) Nainital 
 (c) Salt (Almora) (d) Gan Nath (Almora) 
 

199. Rajaji National Park of Uttarakhand is spread in how many districts ? 
 (a) 1 (b) 2 (c) 3 (d) 5 
 

200. Based on the census data of 2011, match the following and mark the correct answer from 
the codes given below : 
       District  Sex Rate Per 1000 
A. Haridwar 1. 935 
B. Nainital 2. 879 
C. Pauri Garhwal 3. 902 
D. Dehradun 4. 1102 

 Codes : 
  A B C D 
 (a) 1 2 3 4  
 (b) 2 1 4 3 
 (c) 1 3 4 2 
 (d) 4 2 3 1 

___________ 
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190. ˆ¢Ö¸üÖüÜÖÓ›ü Ûêú ×ÛúŸÖ®Öê ×•Ö»Öê †ÓŸÖ¸üÖÔÂ™ÒüßµÖ ÃÖß´ÖÖ ÛúÖê Ã¯Ö¿ÖÔ Ûú¸üŸÖê Æïü ? 
 (a) ¤üÖê  (b) “ÖÖ¸ü  (c) ”û:  (d) ¯ÖÖÑ“Ö  
 

191. ˆ¢Ö¸üÖÜÖÓ›ü ´Öë ‘ ÝÖœÌüÛêúÃÖ¸üß’  ×ÛúÃÖê ÛúÆüÖ •ÖÖŸÖÖ Æîü ? 
 (a) †®ÖÃÖæµÖÖ ¯ÖÏÃÖÖ¤ü ²ÖÆãüÝÖãÞÖÖ  (b) ³ÖŒŸÖ ¤ü¿ÖÔ®Ö  
 (c) ´ÖãÛãú®¤üß »ÖÖ»Ö  (d) Ûêú¿Ö¸üØÃÖÆü ¸üÖ¾ÖŸÖ  
 

192. ‘ ÝÖÖê×¾ÖÂÖÖÞÖ’  ÛúÖ ¾ÖŸÖÔ´ÖÖ®Ö ®ÖÖ´Ö ŒµÖÖ Æîü ? 
 (a) ÜÖ™üß´ÖÖ  (b) ÛúÖ¿Öß¯Öã¸ü  (c) ¹ý¦ü¯Öã¸ü  (d) “Ö´¯ÖÖ¾ÖŸÖ  
 

193. ‘œüÖÛú¸ü’ ŒµÖÖ Æîü ? 
 (a) Ûú¸ü  (b) ¯Ö¸ü´¯Ö¸üÖ  (c) ÜÖÖª ÃÖÖ´ÖÝÖÏß µÖÖŸÖÖµÖÖŸÖ (d) Ã£ÖÖ®Ö ÛúÖ ®ÖÖ´Ö  
 

194. “ÖÖê™üß ÛúÖê Ã£ÖÖ®Ö ÃÖê ÃÖã´Öê×»ÖŸÖ Ûú¸ëü †Öî¸ü ®Öß“Öê ×¤ü‹ ÝÖ‹ Ûæú™üÖë ÃÖê ÃÖÆüß ˆ¢Ö¸ü ²ÖŸÖÖ‡‹ : 
                “ÖÖê™üß“ÖÖê™üß“ÖÖê™üß“ÖÖê™üß                                    Ã£ÖÖ®ÖÃ£ÖÖ®ÖÃ£ÖÖ®ÖÃ£ÖÖ®Ö    
 A. ²ÖÓ¤ü¸ü¯ÖæÑ”û 1. “Ö´ÖÖê»Öß 
 B. ¯ÖÓ“Ö“Öæ»Öß 2. ˆ¢Ö¸üÛúÖ¿Öß 
 C. ®Ö®¤üÖ¤êü¾Öß 3. ²ÖÖÝÖê¿¾Ö¸ü 
 D. ®Ö®¤üÖÛúÖê™ü 4. ×¯Ö£ÖÖê¸üÖÝÖœÌü 
    Ûæú™ü :Ûæú™ü :Ûæú™ü :Ûæú™ü :    
  A B C D 
 (a) 1 2 3 4  
 (b) 4 3 2 1 
 (c) 3 2 4 1 
 (d) 1 4 3 2 
 

195. ›üÖò. “ ¯ÖßŸÖÖ´²Ö¸ü ¤ü¢Ö ²Ö›Ìü£¾ÖÖ»Ö ×Æü®¤üß †ÛúÖ¤ü´Öß”  Ûúß Ã£ÖÖ¯Ö®ÖÖ ÛúÆüÖÑ Ûúß ÝÖ‡Ô Æîü ? 
 (a) Æü×¸ü«üÖ¸ü  (b) ®Öî®ÖßŸÖÖ»Ö  (c) ¤êüÆü¸üÖ¤æü®Ö  (d) Šú×ÂÖÛêú¿Ö  
 

196. ˆ¢Ö¸üÖÜÖÞ›ü Ã¾ÖÖÃ£µÖ ‹¾ÖÓ •Ö®ÖÃÖÓÜµÖÖ ®Öß×ŸÖ Ûúß ‘ÖÖêÂÖÞÖÖ ×ÛúÃÖ ¾ÖÂÖÔ Ûúß ÝÖ‡Ô ? 
 (a) 2001  (b) 2002  (c) 2003  (d) 2004  
 

197. ‘¤üÖÓ›üß ´ÖÖ“ÖÔ’  ´Öë ×ÛúÃÖ®Öê ÃÖÆü³ÖÖ×ÝÖŸÖÖ Ûúß £Öß ? 
 (a) ‹´Ö.‹´Ö. ÛúÖÞ›ü¯ÖÖ»Ö  (b) •µÖÖê×ŸÖ¸üÖ´Ö ÛúÖÞ›ü¯ÖÖ»Ö  
 (c) †®ÖÃÖæµÖÖ ¯ÖÏÃÖÖ¤ü ²ÖÆãüÝÖãÞÖÖ  (d) ²Ö¦üß¤ü¢Ö ¯ÖÖÓ›êü  
 

198. ÃÖŸµÖÖÝÖÏ×ÆüµÖÖë Ûêú ¯ÖÏ×¿ÖõÖÞÖ ÆêüŸÖã 1940 ´Öë ‹Ûú ¯ÖÏ×¿ÖõÖÞÖ ×¾ÖªÖ»ÖµÖ ÛúÆüÖÑ ÜÖÖê»ÖÖ ÝÖµÖÖ £ÖÖ ? 
 (a) ¸üÖ®ÖßÜÖêŸÖ (†»´ÖÖê›ÌüÖ)  (b) ®Öî®ÖßŸÖÖ»Ö  
 (c) ÃÖ»™ü (†»´ÖÖê›ÌüÖ)  (d) ÝÖÞÖ®ÖÖ£Ö (†»´ÖÖê›ÌüÖ)  
 

199. ˆ¢Ö¸üÖÜÖÞ›ü ÛúÖ ¸üÖ•ÖÖ•Öß ¸üÖÂ™ÒüßµÖ ˆªÖ®Ö ×ÛúŸÖ®Öê •Ö®Ö¯Ö¤üÖë ´Öë ±îú»ÖÖ Æãü†Ö Æîü ? 
 (a) 1 ´Öë   (b) 2 ´Öë   (c) 3 ´Öë   (d) 5 ´Öë   
 

200. ÃÖ®ÖË 2011 Ûúß •Ö®ÖÃÖÓÜµÖÖ ¯Ö¸ü †Ö¬ÖÖ× ü̧ŸÖ ®Öß“Öê ×¤üµÖê ÝÖµÖê ÛúÖê ÃÖã́ Öê×»ÖŸÖ Ûúß×•ÖµÖê ŸÖ£ÖÖ ®Öß“Öê ×¤üµÖê Ûæú™üÖë ÃÖê ÃÖÆüß ˆ¢Ö ü̧  “Öã×®ÖµÖê : 
        •Ö®Ö¯Ö¤ü•Ö®Ö¯Ö¤ü•Ö®Ö¯Ö¤ü•Ö®Ö¯Ö¤ü        Ø»ÖÝÖÖ®Öã¯ÖÖŸÖ ¯ÖÏ×ŸÖ 1000Ø»ÖÝÖÖ®Öã¯ÖÖŸÖ ¯ÖÏ×ŸÖ 1000Ø»ÖÝÖÖ®Öã¯ÖÖŸÖ ¯ÖÏ×ŸÖ 1000Ø»ÖÝÖÖ®Öã¯ÖÖŸÖ ¯ÖÏ×ŸÖ 1000    
 A. Æü×¸ü«üÖ¸ü 1. 935 
 B. ®Öî®ÖßŸÖÖ»Ö 2. 879 
 C. ¯ÖÖî›Ìüß ÝÖœÌü¾ÖÖ»Ö 3. 902 
 D. ¤êüÆü¸üÖ¤æü®Ö 4. 1102 
    Ûæú™ü :Ûæú™ü :Ûæú™ü :Ûæú™ü :    
  A B C D 
 (a) 1 2 3 4  
 (b) 2 1 4 3 
 (c) 1 3 4 2 
 (d) 4 2 3 1 

___________ 
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Space For Rough Work / ̧ü±ú ÛúÖµÖÔ Ûêú ×»Ö‹ •ÖÝÖÆ¸ü±ú ÛúÖµÖÔ Ûêú ×»Ö‹ •ÖÝÖÆ¸ü±ú ÛúÖµÖÔ Ûêú ×»Ö‹ •ÖÝÖÆ¸ü±ú ÛúÖµÖÔ Ûêú ×»Ö‹ •ÖÝÖÆ    
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Space For Rough Work / ̧ü±ú ÛúÖµÖÔ Ûêú ×»Ö‹ •ÖÝÖÆ¸ü±ú ÛúÖµÖÔ Ûêú ×»Ö‹ •ÖÝÖÆ¸ü±ú ÛúÖµÖÔ Ûêú ×»Ö‹ •ÖÝÖÆ¸ü±ú ÛúÖµÖÔ Ûêú ×»Ö‹ •ÖÝÖÆ    
 


